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Rosemount™ Tank Gauging

NOTICE

Read this manual before working with the product. For personal and system safety, and for optimum product performance,
ensure you thoroughly understand the contents before installing, using, or maintaining this product.

For equipment service or support needs, contact your local Emerson Automation Solutions/Rosemount Tank Gauging
representative.

Version

This manual is based on the functionality of TankMaster WinSetup version 6.x. For older TankMaster versions all functionality
described in this manual may not be available and the Graphical User Interface (GUI) may look different.
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1 Introduction

1.1 Manual overview
This manual provides information on installation, configuration and maintenance of the
Rosemount™ 2410 Tank Hub.

Chapter Introduction provides a brief description of the various components in a
Rosemount Tank Gauging system.

Chapter Device installation is a description of how to use TankMaster WinSetup to install
devices in a Rosemount Tank Gauging system.

Chapter Tank installation is a description of how to use TankMaster WinSetup to install
tanks and associate devices to tanks in a Rosemount Tank Gauging system.

Chapter Device handling is a short description of the basic functions for changing device
configuration and how to uninstall devices from the WinSetup workspace.

Reference Manual Introduction
00809-0300-5100 February 2022

Rosemount Tank Gauging 5



1.2 Technical documentation
The Rosemount™ Tank Gauging System includes a wide portfolio of user documentation.
For a complete list, see product pages on Emerson.com/Rosemount.

Reference manuals

• Rosemount Tank Gauging System Configuration Manual (00809-0300-5100)

• Rosemount 2460 System Hub (00809-0100-2460)

• Rosemount 2410 Tank Hub (00809-0100-2410)

• Rosemount 5900S Radar Level Gauge (00809-0100-5900)

• Rosemount 5900 Proof Test with Reference Reflector (00809-0200-5900)

• Rosemount 5900C Radar Level Gauge (00809-0100-5901)

• Rosemount 2240S Multi-Input Temperature Transmitter (00809-0100-2240)

• Rosemount 2230 Graphical Field Display (00809-0100-2230)

• Rosemount 5300 Guided Wave Radar (00809-0100-4530)

• Rosemount 5408 Radar Level Transmitter (00809-0300-4408)

• Rosemount Tank Gauging Wireless System (00809-0100-5200)

• Rosemount TankMaster WinOpi (00809-0200-5110)

• Rosemount TankMaster Software Installation Manual (00809-0400-5110)

• Rosemount TankMaster WinSetup (00809-0100-5110)

• Rosemount TankMaster Floating Roof Monitoring (00809-0500-5100)

• Rosemount TankMaster Network Configuration (303042EN)

• Rosemount 5900 Radar Level Gauge and Rosemount 2410 Tank Hub Safety Manual
Option S (00809-0400-5100)

• Rosemount TankMaster Mobile User Guide (00809-0100-5120)

• Rosemount TankMaster Mobile Installation Manual (00809-0200-5120)
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Product data sheets

• Rosemount Tank Gauging System (00813-0100-5100)

• Rosemount TankMaster Inventory Management Software (00813-0100-5110)

• Rosemount TankMaster Mobile Inventory Management Software (00813-0100-5120)

• Rosemount 2460 System Hub (00813-0100-2460)

• Rosemount 2410 Tank Hub (00813-0100-2410)

• Rosemount 5900S Radar Level Gauge (00813-0100-5900)

• Rosemount 5900C Radar Level Gauge (00813-0100-5901)

• Rosemount 2240S Multi-input Temperature Transmitter (00813-0100-2240)

• Rosemount 565/566/765/614 Temperature and Water Level Sensors
(00813-0100-5565)

• Rosemount 2230 Graphical Field Display (00813-0100-2230)

• Rosemount 5300 Level Transmitter (00813-0100-4530)

• Rosemount 5408 Level Transmitter (00813-0100-4408)

Reference Manual Introduction
00809-0300-5100 February 2022

Rosemount Tank Gauging 7

https://www.emerson.com/documents/automation/104590.pdf
https://www.emerson.com/documents/automation/81210.pdf
https://www.emerson.com/documents/automation/7468264.pdf
https://www.emerson.com/documents/automation/104538.pdf
https://www.emerson.com/documents/automation/104516.pdf
https://www.emerson.com/documents/automation/104522.pdf
https://www.emerson.com/documents/automation/104528.pdf
https://www.emerson.com/documents/automation/104518.pdf
https://www.emerson.com/documents/automation/81216.pdf
https://www.emerson.com/documents/automation/104524.pdf
https://www.emerson.com/documents/automation/73580.pdf
https://www.emerson.com/documents/automation/202468.pdf


1.3 Document structure

Figure 1-1: System and User Documentation Structure
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A. Rosemount TankMaster WinSetup Reference Manual
B. Rosemount TankMaster WinOpi Reference Manual
C. Rosemount TankMaster Software Installation Manual
D. Rosemount 2460 System Hub Reference Manual
E. Rosemount Tank Gauging System Configuration Manual
F. Rosemount 2410 Reference Manual
G. Rosemount 5900S Reference Manual
H. Rosemount 5900C Reference Manual

I. Rosemount 2240S Reference Manual
J. Rosemount 2230 Reference Manual

Introduction Reference Manual
February 2022 00809-0300-5100

8 Emerson.com/Rosemount



2 Device installation
This section describes how to install and configure a Rosemount Tank Gauging system by
using the Rosemount TankMaster WinSetup configuration program.

2.1 System configuration overview

2.1.1 Preparations
Before installing a Rosemount Tank Gauging system you should ensure that the following
information is available:

• A plan of all field devices and tanks.

• Unit IDs of each device (Unit ID is a unique identifier given to each device at factory).

• Modbus® addresses of level devices and ATD devices. The devices are shipped with
default addresses which will be changed at system configuration. The Modbus
addresses are configured in the Rosemount 2460 System Hub’s Tank Database as well
as the Rosemount 2410 Tank Hub’s Tank Database as described below.

• Tank geometry parameters and reference distances such as tank Reference height (R)
and distance between Zero level (datum plate) and tank bottom.

• Antenna type for the various level gauges.

2.1.2 Installation procedure
Installation and configuration of a Rosemount Tank Gauging system includes the following
steps as briefly described below.

Procedure

1. Setup communication protocols.

Specify communication protocol parameters:

• The Modbus® Master Protocol handles communication between a TankMaster
work station and field devices such as the Rosemount 2460 System Hub and the
Rosemount 2410 Tank Hub.

• The Slave Protocol handles communication with a host computer.

• Communication with TankMaster can be supervised by logging various error
types and function codes.

2. Configure preferences.

Specify measurement units, tag prefixes for tank and device labels, inventory
parameters, and parameters to be displayed when viewing tank data.

Reference Manual Device installation
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3. Install and configure the Rosemount 2460 System Hub.

The Rosemount 2460 System Hub has to be installed and configured prior to
installing other devices such as a Rosemount 2410 Tank Hub and a Rosemount
5900S Radar Level Gauge.

a) Assign a Modbus communication address

b) For each communication port, configure protocol and appropriate
communication parameters

c) Configure the Tank Database with information about the devices connected
to the fieldbus

4. Install and configure Rosemount 2410 Tank Hubs.

The Rosemount 2410 Tank Hub should be installed after the Rosemount 2460
System Hub and prior to the other field devices. In case no system hub is used, the
tank hub can be connected directly to a TankMaster work station. Installing a
Rosemount 2410 Tank Hub includes the following main steps:

a) Specify a device tag

b) Assign a Modbus communication address

c) Configure the Tank Database to map devices to tanks

d) Optional: Configure the local display

5. Install and configure field devices

In a Rosemount Tank Gauging system, the field devices such as level gauges and
temperature transmitters, are installed in TankMaster WinSetup as part of the
Rosemount 2410 installation procedure. The devices are configured at a later stage
by using the Properties window for each device.

Installation and configuration of devices include the following steps:

a) Communication: specify protocol and address.

b) Configuration: specify tank geometry parameters, device specific
parameters, temperature element positions, and other parameters
depending on the device type.

6. Install and configure tanks.

Installing a tank includes the following steps:

a) Select tank type. Select one of the available options such as Fixed Roof,
Floating Roof, Sphere LPG, Horizontal LPG, or any other suitable tank type.

b) Specify a tank tag. The name will be used as an identifier in the Workspace
window and other TankMaster windows.

c) Select devices. Associate devices to the tank.

d) Configuration. Specify the available source signals for parameters such as
Free Water Level, Vapor Pressure and Liquid Pressure.

e) Value Entry. Specify an approved value range for Level, Ullage, and Free
Water Level. In case there is no source instrument available, you can specify
manual values to be used instead.

Device installation Reference Manual
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7. Calibrate.

Once a Rosemount 5900 Radar Level Gauge is installed and configured, the
Calibration Distance parameter may have to be adjusted in order to ensure that
measured level and actual product level match. The adjustment should be
performed once at the final commissioning.
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Installation procedure

Figure 2-1: Rosemount Tank Gauging system installation Procedure
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2.1.3 Using the device installation wizard
The device installation wizard guides you step-by-step through the installation procedure.

Procedure

1. In the TankMaster WinSetup workspace, select the Devices folder.

2. Do one of the following:
• Click the right mouse button and select Install New from the popup menu.

• From the Service menu select Devices → Install New.

Starting device installation wizard from File menu
As an alternative method to start the device installation wizard you can use the following
method.

Procedure

1. In the TankMaster WinSetup workspace, select the server where your system is
installed.

2. From the File menu select Install New → Device.

Reference Manual Device installation
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2.2 Communication protocol setup
The TankMaster work station can be connected to field devices and host computers by
using Master and Slave protocols. The Modbus Master protocol is available as default
protocol when the Rosemount TankMaster software is installed on a TankMaster work
station. Optional protocols, such as the Modbus® Slave protocol for communication with
host systems, can be obtained as well. Please contact Emerson Automation Solutions/
Rosemount Tank Gauging for more information.

A Modbus protocol offers up to eight channels. Enraf and HART protocols support 16
channels. For each channel you can specify various settings such as communication type
(for example Modbus TCP or Modbus RTU) and which PC communication port (USB/COM)
to connect to, as well as standard communication parameters such as Baud Rate, Parity,
and number of Stop Bits.
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Figure 2-2: Communication with Various Rosemount Tank Gauging Devices
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2.2.1 Master protocol channel configuration
This section describes how to configure the Modbus® Master protocol channel by using
Rosemount TankMaster WinSetup.

Procedure

1. Open the Protocols folder in the Workspace window.

2. Select the icon that corresponds to the particular protocol to be configured (this
example shows the Modbus Master protocol).

3. Click the right mouse button and select Properties, or from the Service menu select
Protocols → Properties.

4. The Protocol Properties window lists the available protocol channels. For each
channel the corresponding icon indicates whether the channel is enabled or
disabled.

5. Select the desired channel.

Device installation Reference Manual
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6. Click the Properties button to configure the protocol channel.

7. Select the Communication tab. It allows you to configure parameters for
communication between field devices and TankMaster work station.

a) Modbus TCP; specify IP address for the Rosemount 2460 System Hub that
the TankMaster server is connected to. For redundant system hubs, you may
use a separate IP address for the backup server.

b) Modbus RTU; click the Advanced button in case you need to configure the
communication parameters.

Note
If the communication is interrupted and handshaking includes DSR, no query
will be sent from the TankMaster Protocol Server. This may result in a Query
Timeout.

8. The Communication disabled in backup mode check box can be used for systems
with redundant tank servers. If the check box is selected, the ModbusMaster will not
send any queries if the local tank server is in backup mode.

9. Select the Enable Channel check box to activate the protocol channel.

10. The File Log tab lets you specify what type of information to be logged and saved to
disk.

Reference Manual Device installation
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11. Click the OK button to store the current configuration and close the configuration
window.

The Modbus Master Channel icon (channel no. 1 in this example) appears in the
WinSetup workspace:

Related information

Default Modbus RTU communication parameters
Rosemount 2460 Reference Manual
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Default Modbus RTU communication parameters

Table 2-1: Default Communication Parameters for Modbus RTU

 Parameter Description

Port The COM port that the Rosemount 2180 will be connected to

Baud rate 4800

Stop bits 1

Parity None

Modem Choose FBM 2180 for the Rosemount 2180 Field Bus Modem
Available options:

• FBM 2180

• FBM 2170/71

• RS232

• RS485

Handshaking • FBM 2180: None

• FBM 2170/2171: RTS/CTS/DTS/DSR

• RS485: RTS/CTS

• RS232: None

Reply timeout 1000 ms

Retries 10

Description Text that describes the configured channel

Related information

Master protocol channel configuration
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2.2.2 Slave protocol channel configuration
A Slave protocol allows you to collect data from the TankMaster workstation to a host
computer.

Modbus® communication setup

Prerequisites

A hardware key must be installed in order to run a slave protocol server. Host
communication needs to be enabled.

Procedure

1. Open the Protocols folder in the Workspace window.

2. Select the ModbusSlave protocol icon.

3. Click the right mouse button and select Properties, or select Service → Protocols
→ Properties.

4. The Protocol Properties window lists enabled and disabled protocol channels.

Device installation Reference Manual
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5. Select the desired protocol channel and click the Properties button to open the
configuration window.
.

6. Select the Communication tab.

a) Modbus TCP; verify correct port.

b) Modbus RTU; click the Advanced button in case you need to configure
parameters for proper communication with the host.

Note
If the communication is interrupted and handshaking includes DSR, no query
will be sent from the TankMaster Protocol Server. This may result in a Query
Timeout.

7. Select the Enable Channel check box to activate the protocol channel.

8. Verify communication address and enter optional description:

Address Set the Modbus address to be used by the host computer to
identify the TankMaster workstation.

Description Optional text to describe the configured channel.

Backup mode • None

• Write Commands Rejected means that TankMaster does not
accept any write commands from the host system to device
database registers
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• In Silent mode the Modbus Slave protocol will not send any
replies to requests coming from the host computer while the
local tankserver is in backup mode

Note
If the communication is interrupted and handshaking includes DSR, no query will be
sent from the TankMaster Protocol Server. This may result in a Query Timeout.

9. Click the OK button to store the current configuration and close the configuration
window.

Related information

Advanced Modbus RTU slave protocol configuration

Device installation Reference Manual
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Advanced Modbus® RTU slave protocol configuration
The Advanced Communication window lets you configure modem communication
parameters, delay times, and time-outs for the Modbus RTU Slave protocol.

Procedure

1. In the Slave Protocol Channel Configuration window, select the Communication tab
and click the Advanced button:

2. The following default values are used for the TRL2 Modbus Slave protocol:

Modem Choose the appropriate interface

Baud rate Enter appropriate value for communication with the
host

Stop bits Enter appropriate value for communication with the
host

Parity Enter appropriate value for communication with the
host

Handshaking • FBM 2180: None

• RS485, RS232: See specifications for the
communication software used on the host system

Query to Response Delay 10 ms

Query interval 100 ms

Read Query Timeout 400 ms

Write Response Timeout 400 ms

Max. Response Time 800 ms
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Tank mapping configuration
The slave protocol allows you to send data from a Rosemount Tank Gauging system to a
host computer. In the Tank Mapping window you can specify from which tanks to collect
data for the host system.

Procedure

1. In the Slave Protocol Channel Configuration window, select the Tank Mapping tab.

2. From the list of tanks that appear in the Available Tanks pane, select the tanks that
the host will connect to.

3. Click the  (right arrow) button to move the selected tanks to the list of mapped
tanks.

Important
Ensure that the tanks appear in the order required by the host system.

When the host sends a query, TankMaster responds by sending tank data in the
order as the tanks are listed in the Mapped Tanks column. You can easily change the
position of mapped tanks by using the up arrow and down arrow buttons.

4. Click the OK button to save the current configuration and close the window.

Device installation Reference Manual
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2.2.3 Log file configuration
See the Rosemount TankMaster WinSetup Reference Manual for more information on how
to store a communication log on disk.
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2.2.4 Changing the current protocol channel configuration
The channel configuration can be changed at any time.

Procedure

1. In the WinSetup Workspace, open the Protocols folder and the protocol sub folder
with the enabled channels.

2. Select the desired channel icon.

3. Click the right mouse button and select Properties, or from the Service menu select
Channels → Properties.

4. Select the appropriate tab and change protocol settings as required.
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2.2.5 Protocol server configuration
You can specify which protocol servers that will be connected when starting TankMaster
WinSetup.

Procedure

1. In the WinSetup workspace select the Protocols folder.

2. Click the right mouse button and select Configure.

3. In the Connect column, select check boxes of the protocols to be automatically
connected when WinSetup starts up.

Disable a protocol server
You may disable a protocol server at any time by using the Disable command.

Procedure

1. In the WinSetup workspace, open the Protocols folder.

2. Click the right mouse button on the desired protocol server icon and select Disable.
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2.3 Preferences

2.3.1 Measurement units
Specify units for inventory calculations and measured variables such as level and
temperature. To change measurement units do the following:

Procedure

1. Select the desired server (e.g. “This Workstation”) in the WinSetup workspace.

2. Click the right mouse button and select Setup, or from the Service menu select
Servers → Setup.

3. In the Server Preferences window select the Units tab.

4. Select the desired measurement units for level/ullage, temperature, pressure,
volume, density, and weight.

5. Click the OK button to save the current setting and close the window.

Note
Make sure that the desired measuring units are specified before installing new tanks
and devices.
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Changing measurement units for existing tanks
Configuration of measurement units in the Server Preferences window only affect
installation of new tanks. For tanks which are already installed in the WinSetup Workspace
you will have to follow this procedure.

Procedure

1. Uninstall the tank.

2. Change measurement units in the Server Preferences/Units window (or in the
TankMaster WinOpi program choose menu option Setup → System and change
units in the System Setup window).

3. Install the tank again.
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2.3.2 Ambient Air Temperature
This section describes how to change the Ambient Air Temperature preferences.

Procedure

1. Select the desired server (e.g. “This Workstation”) in the WinSetup workspace.

2. Click the right mouse button and select Setup, or from the Service menu select
Servers → Setup.

3. In the Server Preferences window select the Ambient Air Temperature tab:

4. Choose Auto when there is a temperature sensor available that can be used for
Ambient Air Temperature measurements. Otherwise, select the Manual option and
type a value for the Ambient Air temperature.

Device Click the browse button and select the device to which a
temperature sensor is connected.

Source Select temperature source associated with the selected device. In a
Rosemount Tank Gauging system the associated temperature
transmitter has to be configured in the tank database of the
Rosemount 2410 Tank Hub.

Sensor Select a specific sensor to be used for Ambient Air Temperature.

Value
Range

Value Range defines the minimum and maximum values when
Ambient Air Temperature is manually entered.

5. Click the OK button to save the current setting and close the window.

Related information

Installing a Rosemount 2410 Tank Hub
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2.3.3 Inventory
Local Gravity and Ambient Air Density calculations are used for automatic density
measurements. This is a description on how to change those Inventory settings.

Procedure

1. Select the desired server (e.g. “This Workstation”) in the WinSetup workspace.

2. Click the right mouse button and select Setup, or from the Service menu select
Servers → Setup.

3. In the Server Preferences window select the Inventory tab:

4. Local Gravity is used for density and weight calculations when an optional pressure
transmitter is installed.

• Select Manual if you want to use a specific value for the Local Gravity.

• Select Calculated if you want local gravity to be calculated by TankMaster. In this
case you need to enter Latitude and Elevation of the site.

5. Ambient Air Density is used for calculating Observed Density and Weight in Air
(WIA).

• Select Manual if you want to use a specific value for Ambient Air Density.

• Select Calculated if you want the Ambient Air Density to be calculated by
TankMaster. The calculated value is based on the Base Density and the Ambient
Air Temperature.

See the TankMaster WinOpi Reference Manual for more information on inventory
parameters and calculations.

6. Click the OK button to save the current settings and close the window.
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2.3.4 Miscellaneous
This is a description of how to change parameters such as type of Tank Capacity Table or
Reference Temperature.

Procedure

1. Select the desired server (e.g. “This Workstation”) in the WinSetup workspace.

2. Click the right mouse button and select Setup, or from the Service menu select
Servers  → Setup.

3. In the Server Preferences window select the Miscellaneous tab.

4. Choose the type of Tank Capacity Table (TCT) to be used as default setting when
installing new tanks. The default TCT type will automatically be chosen when
strapping tables are created for new tanks. However, the TCT type can be changed
when the strapping table is specified in the Tank Capacity Setup window regardless
of the settings in the Server Preferences window.

You can choose between TCT type Raw, International, and Northern(1).

5. Specify the maximum number of Digital Alarms that will be used.

6. Specify the Reference Temperature to be used for inventory calculations.
Normally, the standard value 15 °C is used.

7. Click the OK button to save the current settings and close the window.

(1) See the TankMaster WinOpi Reference Manual for further information.
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2.3.5 Setting the name tag prefixes
TankMaster WinSetup allows you to specify default name tag prefixes that will appear
automatically when installing new tanks and devices. Note that Tank Tag must begin with
a letter. These prefixes can be ignored if you want to use other prefixes instead.

Procedure

1. From the Service menu select Preferences.

2. In the Preferences window select the Tag Prefixes tab.

3. Type the prefixes to be used for tank names and device names. and click the OK
button.

You can change the prefixes later at any time.

Note
Changing tag prefixes will not affect names of existing tanks and devices.
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2.3.6 Email configuration
TankMaster WinSetup allows you to setup an e-mail client for alarm notifications and
reports.

Procedure

1. From the Service menu select Preferences.

2. In the Preferences window select the E-mail Configuration tab.

3. Enter the following information:

SMTP Server Specify an SMTP server for outgoing messages. Contact
your LAN administrator or Internet Service Provider (ISP) for
details.

Sender Address The e-mail account which will send e-mails from the current
workstation must be located on the specified SMTP server.

SMTP Port Contact your LAN administrator or ISP for details.

Authentication
Configuration

Select this option and enter a Login name and Password if
authentication is required on the mail server. Contact your
LAN administrator or ISP for details.

Channel Security
Configuration

Select this option if the e-mail client requires the use of
channel security. Contact your LAN administrator or ISP for
details.

Subject Enter a title for an e-mail alarm notification. This subject is
only used for Alarm notification and is optional. This subject
will not be used for other e-mails sent from the built-in e-
mail client.
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2.3.7 Tank View layout
The Setup Tank View tab is used to specify variables to be presented in the Tank View
window, see the Rosemount TankMaster WinSetup Reference Manual for more information.
TankMaster WinSetup allows you to create a new tank view layout and store it on disk, or
load an existing table layout from disk.

Procedure

1. From the Service menu select Preferences.

2. In the Preferences window select the Setup Tank View tab.

3. Click the Load Table button if you wish to edit an existing Table Layout.

4. In the Available Parameters pane on the left-hand side of the Preferences/Setup Tank
View window, select the parameter to be presented in the Tank View window.

5. Click the Move button to move it to the Selected Parameters pane on the right-hand
side of the Preferences/Setup Tank View window.

6. Repeat this procedure for each parameter you wish to include. The Move All button
allows you to move all variables at once to the Selected Parameters list box.
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7. Ensure that all parameters to appear in the Tank View window are included in the
Selected Parameters list box as illustrated below:

8. Click the Save As button if you wish to store the current tank view table for future
use.

9. Click the OK button to save the current Tank View settings and close the window.

Note
When clicking the Apply or the OK button, the parameter setup is stored in the
table layout that is currently used by the Tank View window.
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10. To view the specified tank parameters click the right mouse button and select Open
Tank View:

The Tank View window shows the selected parameters as configured in the Setup
Tank View.
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2.3.8 Tank visibility
The Tanks Visibility tab lets you configure tanks on a remote tank server to make them
visible on the current TankMaster WinOpi client.

Procedure

1. From the Service menu select Preferences.

2. In the Preferences window select the Tanks Visibility tab.

3. Select the Enable Tank Visibility function check box.

4. From the Select tank server drop-down list select the remote tank server on which
the tanks are installed.

5. In the Select tanks to be visible on this workstation pane, check the tanks you wish to
make visible on the current workstation.

In the default setting all tanks are visible.

6. Select Visible on this workstation in case you would like to make tanks installed on
a remote server automatically visible on the current workstation as well.
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7. Click the OK button to store the current configuration and close the Preferences
window.

Figure 2-3: Tanks Visibility Enabled for All Tanks

Figure 2-4: One Tank Disabled from Visiblity (TK-X)
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2.4 Field device installationoverview
The Rosemount TankMaster software supports many field devices, for example:

• Rosemount 2460 System Hub

• Rosemount 2410 Tank Hub

• Rosemount 5900 Radar Level Gauge

• Rosemount 2240S Multi-input Temperature Transmitter

• Rosemount 2230 Graphical Field Display

• Rosemount 5408 Radar Level Transmitter

• Rosemount 5300 Guided Wave Radar

• Rosemount 3051/3051S Pressure Transmitter

• Rosemount 644 Temperature Transmitter

2.4.1 Configuration
A TankMaster installation includes configuration of the Rosemount Tank Gauging system
for communication with the TankMaster work station and field devices as well as
configuration of device specific parameters.

Configuration of radar level gauges includes:

• mapping to a specific tank

• communication parameters

• device specific parameters

• tank geometry

• tank environment parameters

Configuration of Auxiliary Tank Devices (ATDs) includes:

• communication address

• mapping of measurement variables to source devices

• Rosemount 2240S Multi-input Temperature Transmitter or other supported
temperature transmitter

• temperature elements

• water level sensor

• Rosemount 2230 Graphical Field Display

• other supported field devices
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2.5 Installing a Rosemount 2460 System Hub
This is a brief description of how to install and configure a Rosemount 2460 System Hub in
a Rosemount Tank Gauging system.

Procedure

1. Ensure that the Rosemount TankMaster WinSetup program is up and running.

2. Enable and configure a Protocol Channel to establish communication with the
appropriate port on the TankMaster PC.

3. Start the installation wizard in TankMaster WinSetup:

a) Click the right mouse button on the Devices folder.

b) Select the Install new option.

4. Select device type 2460 System Hub.

5. Specify a name tag in the 2460 System Hub Tag input field. This tag will be used as
an identifier of the Rosemount 2460 in various windows and dialogs.

6. Click the Next button to proceed with the installation wizard.

7. Verify that the Host and Field ports are properly configured. Host ports are used for
communication with TankMaster work stations or other host systems. Field ports
are used for communication with the Rosemount 2410 Tank Hub, the Rosemount
5900S Radar Level Gauge, and other field devices.

8. Configure the Tank Database. Ensure that the Modbus® Addresses of the
connected devices are properly set. These addresses must correspond to the
database settings of the Rosemount 2410 Tank Hub.

Related information

Rosemount 2460 Reference Manual
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2.6 Installing a Rosemount 2410 Tank Hub
The installation wizard covers basic configuration of a Rosemount 2410 Tank Hub. If
further configuration of Primary Bus, Secondary Bus, Relay Output, and Hybrid Density
Calculation is required this must be done separately via the 2410 Tank Hub Properties
window.

Related information

Rosemount 2410 Reference Manual

2.6.1 Installing a Rosemount 2410 using the wizard
It is very important that the Tank Database of the Rosemount 2460 System Hub is properly
configured prior to configuring the Rosemount 2410 Tank Hub. This ensures that the
system hub is able to collect data from the different field devices.

Procedure

1. In the Workspace window select the Devices folder.

2. Click the right mouse button and select Install New, or from the Service menu
choose Devices → Install New.
Now the Select Device window appears.
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3. From the Device Type drop-down list, choose the 2410 Tank Hub option.

4. Type a name in the 2410 HUB Tag input field. The tag will be used as an identifier for
the Rosemount 2410 Tank Hub in various windows and dialogs.

5. Click the Next button to proceed with communication settings.

Related information

Installing a Rosemount 2460 System Hub
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Communication setup

Procedure

1. Specify whether TankMaster communicates directly with the Rosemount 2410
Tank Hub, or via a Rosemount 2460 System Hub.

2. If the tank hub is connected to a system hub, select the appropriate system hub
from the 2460 Tag drop-down list.

3. If the tank hub is connected directly to a TankMaster PC and not via a system hub,
specify the communication protocol channel which is associated with the
communication port on the TankMaster workstation. To check which channels are
enabled:

a) in the WinSetup workspace open the Protocols folder

b) click the right mouse button on the ModbusMaster protocol icon

c) choose the Properties option

To check which communication port that is associated with a certain channel:

a) right-click the protocol channel icon

b) open the Communication tab and check which communication port that is
selected.
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4. To verify communication with the tank hub, type the current Modbus address and
click the Verify Communication button. The Unit Id will appear if the correct
Modbus address was entered (the tank hub is shipped with the default Modbus
address=247).

Note
In case several Rosemount 2410 Tank Hubs are connected using the same default
address (247), you will have to change the addresses before the Verify command
can be used.

5. In the 2410 Tank Hub Communication window click the Next button to continue the
installation procedure of the tank hub.

Related information

Master protocol channel configuration
How to change the Modbus address of the Rosemount 2410

How to change the Modbus® address of the Rosemount 2410

Procedure

1. In the 2410 Tank Hub Communication window click the Change Address on Device
button to open the Change Address window.

2. Enter the Unit ID and the new Modbus Address. When changing the device
address, the Unit Id is used as a unique identifier of the device. The Unit Id can be
found on a label mounted on the device.

Tip
If there is no other device connected that uses the same address as the current
device, you can find the Unit Id by typing the current address into the Address field
in the 2410 Tank Hub Communication window and clicking the Verify
Communication button.

3. Click the OK button to confirm the address settings and close the Change Address
window.

4. In the 2410 Tank Hub Communication window click the Verify Communication
button to check that communication is established between the TankMaster work
station and the Rosemount 2410 Tank Hub. The Unit ID will appear when
TankMaster finds the tank hub.
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Tank Database setup
Each tank is represented by a position in the Rosemount 2410 tank database. Each device
connected to the Rosemount 2410 is mapped to a tank position. For each tank position, a
name is assigned as an identifier of the tank. The tank database maps field devices to the
various tanks, and identifies the devices whenever there is a request for measurement
data from a Rosemount 2460 System Hub.

Procedure

1. The Device Type column lists all devices that communicate on the Tankbus. Ensure
that all devices connected to the Tankbus appear in the Device Type list to verify
proper communication.

2. In the Tank Position column, map each device to a tank by selecting the
appropriate number from the drop-down list in the tank database.

Example

The example below illustrates a tank connected to a Rosemount 2410 Tank Hub.
Note that tank positions which are mapped to devices are enabled for editing. You
may change tank name and Modbus® address in the right-hand side of the Tank Hub
Tank Database window.
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3. Optional: A multiple tanks version of the Rosemount 2410(2) allows you to connect
several tanks to a single tank hub.

Example

The example below illustrates three tanks connected to a tank hub for multiple
tanks.

4. Type the desired names in the Tank Name field. These tank names should also be
used at a later stage when installing the tanks associated with the current
Rosemount 2410 Tank Hub.

5. For each tank, specify a Modbus address in the Level Modbus Address column to be
associated with the level gauge. This must be the same Modbus address as
configured in the tank database of the Rosemount 2460 System Hub. The Level
Modbus Address is used to identify level gauges when distributing requests for
measurement data from the system hub.

(2) Multiple tank version of the Rosemount 2410 Tank Hub requires model code option M. See the Rosemount Tank Gauging
System Data Sheet for more information.
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6. The various non-level devices on a tank are represented by a single ATD device in
the Rosemount Tank Gauging system.

• In tank position 1, the Rosemount Tank Gauging system uses the Modbus
address of the Rosemount 2410 Tank Hub itself as the ATD Modbus address. In
the example above, the tank hub has Modbus address 101. This address is
automatically used as the ATD Modbus address as well.

• For tank positions 2 to 10(2) you need to specify Modbus addresses in the ATD
Modbus Address column to be associated with the different ATD devices.

Important
The ATD Modbus addresses must be the same as configured in the Rosemount
2460 System Hub’s tank database.

• An empty ATD Modbus address field indicates that no ATD device is mapped to
that particular tank position.

7. Click the Next button to continue the installation procedure.

Related information

Installing a Rosemount 2460 System Hub
Rosemount 2460 Reference Manual
Installing a tank

Device installation Reference Manual
February 2022 00809-0300-5100

48 Emerson.com/Rosemount

https://www.emerson.com/documents/automation/81354.pdf


Device Tag setup
Level Tags and ATD Tags are configured automatically based on tank names in the 2410
Tank Hub Tank Database window and the configuration of tag prefixes in the
Preferences/Tag Prefix window. However, it is possible to edit the Level Tag and ATD Tag
fields.

Procedure

1. Verify that the TankMaster Level Tag is correct or type a new one.

2. Verify that the TankMaster ATD Tag is correct or type a new one. In case the ATD
tag field is empty and disabled then no ATD device is associated with that tank
position.

3. Click the Next button to continue the installation procedure.

Related information

Setting the name tag prefixes
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Local display setup
Choose the parameters to be displayed on the integral display panel on the Rosemount
2410 Tank Hub. The display will alternate between the selected items at a rate given by
the Display Toggle Time.

Procedure

1. In the Units for Display pane, choose the desired measurement units from the drop-
down lists. These measurement units will be used by the 2410 local display when
presenting various tank variables.

2. In the Display Tanks pane, select check boxes for the tanks that you want to present
in the Rosemount 2410 integral display.

3. In the Display Tank Parameters pane, choose the tank parameters to be displayed by
checking the appropriate boxes. See Table 2-2 for more information on available
parameters:

Table 2-2: Various Tank Parameters can be Presented on the Local Display

Tank Parameter Description

Level The current product level in the displayed tank.

Distance Distance (ullage) is measured from the Tank Reference
point to the product surface.

Level rate The speed at which the product surface moves when
emptying or filling the tank.

Signal strength The signal strength of the radar level gauge measurement
signal.

Device installation Reference Manual
February 2022 00809-0300-5100

50 Emerson.com/Rosemount



Table 2-2: Various Tank Parameters can be Presented on the Local Display
(continued)

Tank Parameter Description

Free water level Water surface level at the bottom of the tank. Available
when a water level sensor is installed in the tank.

Vapor pressure Tank vapor pressure.

Liquid pressure Product liquid pressure.

Air pressure Ambient air pressure.

Air temperature Ambient air temperature.

Vapor temperature Tank vapor temperature.

Product temperature Average temperature of the product.

Tank temperature Average temperature of product and vapor in the tank.

Temperature 1, 2 ... Temperature value measured by element 1, 2, etc.

Observed density The actual product density at the current product
temperature.

Reference density Density at reference temperature (used for inventory
calculations).

Volume Total observed volume.

User defined 1 to 5 Variables for advanced configuration.

4. Enter the Display Toggle Time. Information on the local display alternates between
the selected items at a rate given by the Display Toggle Time value.

5. The tank hub can be configured to show different parameters for each tank on the
Tank Bus. In the 2410 Tank Hub Local Display window click the Individual Tank
Configuration button:

6. The Display Tanks pane has a list of all tank positions in the tank database. Tank
positions within brackets, for example (Tank Pos 6), are not configured in the
Rosemount 2410’s tank database.
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7. Select the desired tank position and choose which parameters to show on the
display. Repeat this procedure for each tank position.

8. Click the OK button to store the configuration and return to the 2410 Tank Hub
window.

9. Click the Next button to continue the installation procedure.
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Configuration summary
The 2410 Tank Hub Summary window shows information about all devices included in the
Rosemount 2410’s tank database.

Procedure

1. Verify that all Modbus® addresses, level tags and ATD tags presented in the 2410
Tank Hub Summary window are correct. In case you would like to make any changes,
click the Back button until the appropriate configuration window appears.

2. By selecting the Install Level and AUX devices check box, field devices connected
to the tank hub will automatically be installed in the TankMaster workspace. The
check box is selected by default and this is the recommended setting.

Once installed, the devices need to be configured via the Properties window. The
installation procedure will be facilitated by using the Install Level and AUX devices
check box. However, the field devices (level gauge and ATD) can be installed at a
later stage by using the device installation wizard for the respective device.
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3. Click the Finish button to confirm the installation. The installed devices will appear
in the Workspace window.
The installed devices will appear in the Workspace window.

Figure 2-5: Devices Appear in the WinSetup Workspace Window

Postrequisites

Make sure that devices are properly configured.

Related information

Installing a Rosemount 5900 Radar Level Gauge
Installing Auxiliary Tank Devices
Using the device installation wizard
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Advanced configuration

The installation wizard does not include all configuration options available for a
Rosemount 2410 Tank Hub. Further configuration can be done via the 2410 Tank Hub
Configuration window:

• host communication parameters for the Primary Bus

• host communication and emulation parameters for the Secondary Bus

• virtual relays

• hybrid density calculation

See the Rosemount 2410 Tank Hub Reference Manual (00809-0100-2410) for more
information on how to configure a Rosemount 2410 Tank Hub.

Related information

Rosemount 2410 Reference Manual
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2.7 Installing a Rosemount 5900 Radar Level Gauge
This is a description of how to setup a Rosemount 5900 Radar Level Gauge by using the
TankMaster WinSetup configuration software. It applies to the Rosemount 5900S as well
as the Rosemount 5900C. Pictures in the examples below will show the Rosemount 5900S
in most cases, but the functionality is the same for the Rosemount 5900C if not otherwise
stated.

The Rosemount 5900 Radar Level Gauge is typically installed in TankMaster WinSetup as
part of the Rosemount 2410 Tank Hub installation procedure. Once installed, the
Rosemount 5900 is configured via the 5900 RLG Properties window. The 5900 RLG
Properties window includes tabs for basic and advanced configuration.

When connecting a Rosemount 5900 Radar Level Gauge to a Rosemount 2410 Tank Hub
in an existing Rosemount Tank Gauging system, the level gauge needs to be mapped to
the appropriate tank in the tank hub’s database. Configuration is performed via the 5900
RLG Properties window.

A Rosemount 5900 is most conveniently installed by utilizing the integrated option
included as part of the Rosemount 2410 Tank Hub installation procedure.

It can also be installed and configured by using the WinSetup installation Wizard. This
method should only be used in special cases when, for example, the 5900 is connected to
the Tankbus at a later stage and not available when installing the Rosemount 2410 Tank
Hub.

The following configuration steps are included in the Rosemount 5900 Radar Level Gauge
basic configuration:

• communication parameters

• antenna type

• tank geometry

Configuration of a Rosemount may also include:

• Tank Scan

• Empty Tank Handling

Due to the properties of the product, the tank shape, or other circumstances, further
configuration may be needed in addition to the basic configuration. Disturbing objects
and turbulent conditions in the tank may require that advanced measures are taken.
Advanced configuration options include:

• Tank Environment

• Tank Shape

• Surface Echo Tracking

• Filter Settings

Related information

Installing a Rosemount 5900 using the installation wizard
Advanced configuration
Adding a tank
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2.7.1 Configuration via the Properties window
The basic configuration procedure of a Rosemount 5900 Radar Level Gauge is
straightforward and easy to perform. All configuration options are available in the
Rosemount 5900 RLG Properties window. For a basic configuration of the Rosemount 5900
do the following:

Procedure

1. In the WinSetup Workspace window, open the Devices folder and select the
Rosemount 5900S Radar Level Gauge icon.
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2. Click the right mouse button and select Properties, or from the Service menu select
Devices  → Properties.

The Communication, Antenna, and Geometry tabs cover basic configuration of the
Rosemount 5900.

3. Select the Communication tab. Note that a red gauge icon means that the device
needs to be configured.

4. Verify the tank position.

The Connected to 2410 HUB field shows the name of the Rosemount 2410 Tank Hub
and the tank position that the device is mapped to in the tank hub’s database. The
tank position indicates which tank the device is associated with.

In most cases, the Rosemount 2410 single tank version is used for level gauges. In
those cases, only one tank position will be used in the tank hub’s database.

In case the multiple tank version of the Rosemount 2410 is used to connect several
tanks, the level gauge can be mapped to another tank through the 2410 Tank Hub
Properties/Tank Database window:

a) in the WinSetup workspace click the right mouse button on the Rosemount
2410 icon.

b) select Properties and open the Tank Database tab.

c) select the desired tank position.
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5. Verify that the Modbus® address is correct. To change the address:

a) Click the Change button to open the Communication window.

b) Click the Change Address on Device button to open the Change Address
window:

c) Enter the Unit ID. When changing the device address, the Unit Id is used as a
unique identifier of the device. The Unit Id can be found on the main label.

d) Set the desired Modbus address.

e) Click OK to confirm the settings and close the Change Address window.

f) Click OK to close the Communication window.

6. In the 5900 RLG Properties/Communication window click the Apply button to store
the Modbus address in the 5900 holding register.

7. Select the Antenna tab:

8. Select one of the predefined Antenna Types to match the antenna attached to the
level gauge. For predefined antennas, a number of parameters are configured
automatically in order to optimize measurement performance.
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In case there are disturbances close to the nozzle you may need to adjust the Hold
Off Distance. By increasing the Hold Off distance, the measurement range is
reduced in the upper part of the tank.

For non-standard antennas you may choose one of the User Defined antennas.
However, it is recommended that you contact Emerson Automation Solutions/
Rosemount Tank Gauging for advice before using this advanced option.

9. Click the Apply button to save the configuration.

10. Select the Geometry tab:

11. Enter the tank geometry parameters:

a) Tank Reference Height. This is the distance from the hand dip nozzle (Tank
Reference Point) to the Zero Level (Datum Plate) close to the bottom of the
tank.

b) Reference Distance (G). This is the distance from the Gauge Reference Point
to the Tank Reference Point, which is located at the side of the flange that
meets the tank nozzle. G is positive if the Tank Reference Point is located
above the Gauge Reference Point, otherwise G is negative (see Figure 2-6).

When using a Rosemount 5900 with Still-pipe Array antenna and hinged
hatch, the Tank Reference Point is located at the hand-dip plate inside the
hatch. The hand-dip plate is also used as the Gauge Reference Point for this
antenna type, which means that G=0.
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c) Minimum Level Distance (C). This is defined as the distance between the
Zero Level (Dipping Datum Point) and the minimum level for the product
surface. By specifying a C-distance the measuring range can be extended to
the bottom of the tank.

C>0: the level gauge presents negative level values when the product surface
is below the Zero Level. The Show negative level values as zero check box
lets you present product levels below the Zero Level (Datum plate) as equal
to zero.

C=0: measurements below the Zero Level will not be approved, i.e. the RLG
will report “invalid level” if the product level is below the Datum Plate.

Figure 2-6: Reference Distance (G)

G>0

A

B

G<0

A. Tank Reference Point
B. Gauge Reference Point

12. Enter the Calibration Distance. Use this parameter to calibrate the level gauge so
that measured product levels match hand dipped levels. A minor adjustment may
be necessary when the gauge is installed. For example, a minor deviation between
the actual tank height and the value stored in the device database may occur if tank
dimensions according to drawings are not quite up to date with actual dimensions.

For still-pipe applications the Calibrate function in the TankMaster WinSetup
program is a useful tool to configure the Calibration Distance and the Correction
Factor.

13. Optional: Select the Show negative level as zero check box in case you don’t want
the transmitter to show negative level values.

14. Click the OK button to save the configuration and close the configuration window.

Postrequisites

In addition to the configuration steps described above, a basic configuration of the
Rosemount 5900 may include using the Tank Scan function to verify that there are no
disturbing objects in the tank that may interfere with the level measurements. Also, the
Empty Tank Handling function may be used to optimize measurement performance near
the tank bottom.

Related information

Antenna configuration
Tank Database setup
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Advanced configuration
Calibrating the level gauge
Rosemount 5900S Reference Manual
Rosemount 5900C Reference Manual

Device installation Reference Manual
February 2022 00809-0300-5100

62 Emerson.com/Rosemount

https://www.emerson.com/documents/automation/81142.pdf
https://www.emerson.com/documents/automation/81472.pdf


Antenna configuration
In the 5900 Properties/Antenna window several antenna types are available. For some of
them additional configuration is required, such as antenna size and pipe diameter.

Antenna types:

• Horn

• Parabolic

• Still-Pipe Array Fixed

• Still-Pipe Array Hatch

• LPG/LNG

• Cone (5900C)

• Cone Pipe (5900C)

For the LPG/LNG antenna you need to select the appropriate option:

• LPG/LNG 150 PSI + Valve

• LPG/LNG 150 PSI

• LPG/LNG 300 PSI + Valve

• LPG/LNG 300 PSI

• LPG/LNG 600 PSI + Valve

• LPG/LNG 600 PSI

For the Cone antenna the following options are available:

• Cone 4" PTFE

• Cone 4" Quartz

• Cone 6" PTFE

• Cone 6" Quartz

• Cone 8" PTFE

• Cone 8" Quartz

For the Cone Pipe antenna the following options are available:

• Cone Pipe PTFE

• Cone Pipe Quartz

Pipe diameter

For Still-pipe Array, LPG, and Cone Pipe(3) antennas you need to specify Pipe Diameter.
Pipe Diameter parameter compensates for the lower microwave propagation speed inside
a still-pipe. See also “Using the Calibrate function” on page 138 for information on how to
calibrate the 5900 for still-pipe installations.

(3) Rosemount 5900C only

Reference Manual Device installation
00809-0300-5100 February 2022

Rosemount Tank Gauging 63



For pipe antennas it is very important that the accurate pipe diameter is input to WinSetup
in order to avoid scale factor deviations which may result in inaccurate level readings.

For Cone Pipe antennas supplied by factory the following nominal values are
recommended as input in TankMaster WinSetup:

Antenna Nominal Pipe Diameter

Cone Pipe 1 inch 30 mm

Cone Pipe 2 inch 56 mm

Related information

Using the Calibrate function

Antenna size

For Still-pipe Array antennas, various antenna size options are available:

• 5 inch

• 6 inch

• 8 inch

• 10 inch

• 12 inch

User Defined antenna

The User Defined option should only be used for special applications when using non-
standard antennas.

Procedure

1. Choose the appropriate antenna type:

• User Defined Free Propagation

• User Defined Still-Pipe

• User Defined Still-Pipe Array

2. Enter the Tank Connection Length in the TCL input field.

3. For still pipe applications, type the inner diameter of the still pipe in the Pipe
Diameter input field.

4. In case there are disturbances close to the nozzle you may need to adjust the Hold
Off Distance. By increasing the Hold Off distance, the measurement range is
reduced in the upper part of the tank.

5. Select Apply to save the configuration.
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2.7.2 Advanced configuration

In addition to the basic configuration, there are advanced configuration options available
for the Rosemount 5900 Radar Level Gauge. These may be used to optimize measurement
performance for certain applications.

Related information

Installing a Rosemount 5900 Radar Level Gauge

Tank Shape
The Tank Type and Tank Bottom Type parameters optimize the Rosemount 5900 for
various tank geometries and for measurements close to the tank bottom.

Procedure

1. In the 5900 RLG Properties window select the Tank Shape tab:

2. Select a Tank Type option that is similar to the actual tank. Choose Unknown if
there is no applicable option.

3. Select Tank Bottom Type that matches the actual tank. Choose Unknown if there is
no applicable option.

4. Click the OK button to save the configuration and close the window.

Tank Environment
Certain tank conditions may require additional configuration of the Rosemount 5900
Radar Level Gauge in order to optimize measurement performance. By considering

Reference Manual Device installation
00809-0300-5100 February 2022

Rosemount Tank Gauging 65



environmental conditions in the tank, the Rosemount 5900 can compensate for
conditions such as rapid level changes, weak echo signals, or varying surface echo
amplitudes.

Procedure

1. In the 5900 RLG Properties window select the Environment tab:

2. Select the check boxes that correspond to the conditions in the tank. Use as few
options as possible. It is recommended that no more than two options are used
simultaneously.

3. Select Product Dielectric Range from the drop-down list. Select the Unknown
option if the correct value range is unknown or if the contents of the tank is
changing on a regular basis.

4. Click the OK button to save the configuration and close the window.

Related information

Rosemount 5900S Reference Manual
Rosemount 5900C Reference Manual
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Advanced Configuration window

The Advanced Configuration window provides further configuration options. The following
options are available:

• Tank Scan(4)

• Empty Tank Handling(4)

• Surface Echo Tracking

• Safety Alarm (only used for SIL safety systems)

Figure 2-7: The 5900S RLG Properties/Advanced Configuration window

Related information

Rosemount 5900S Reference Manual
Rosemount 5900C Reference Manual

(4) May also be used in Basic configuration
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2.7.3 Installing a Rosemount 5900 using the installation
wizard
The installation wizard in TankMaster WinSetup is a tool that may be used to install and
configure various devices in a Rosemount Tank Gauging system.

Field devices are typically installed as part of the installation procedure for a Rosemount
2410 Tank Hub. However, the installation wizard lets you install devices in TankMaster
separately from the tank hub installation.

Prerequisites

Ensure that the tank databases of the Rosemount 2460 System Hub and the Rosemount
2410 Tank Hub are properly configured for the new Rosemount 5900.

Ensure that the correct Modbus® address is configured for the new device.

Procedure

1. In the Workspace window select the Devices folder.
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2. Click the right mouse button and select Install New, or from the Service menu
select Devices → Install New.

3. Select Device Type 5900S Radar Level Gauge from the drop-down list.

4. Enter the desired tag for identifying the device.

5. Click the Next button to open the 5900 RLG Communication window:

6. In the 2410 HUB Tag drop-down list, select the tank hub that the Rosemount 5900
Radar Level Gauge is connected to. Normally, there is one tank hub for each tank.

7. Enter the Modbus address. This address must be available in the tank databases of
the Rosemount 2460 System Hub and the Rosemount 2410 Tank Hub.

8. Click the Verify Communication button to confirm that the TankMaster PC
communicates with the device. The Unit ID will appear when contact is established.
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9. Check the Position in 2410 HUB field to verify that the device is mapped to the
correct tank position in the Rosemount 2410 tank database. The tank position
indicates which tank the device is associated with. Normally, the single tank version
of the Rosemount 2410 Tank Hub is used for level gauges. In those cases the
Position in 2410 HUB field will be equal to 1 since there is only one tank position
that is used in the tank hub's database.

In case the multiple tank version of the Rosemount 2410 Tank Hub is used for
several tanks, the level gauge can be mapped to the desired tank via the 2410 Tank
Hub Properties/Tank Database window:

a) In the WinSetup workspace, click the right mouse button on the tank hub
icon.

b) Select the Properties option.

c) Select the Tank Database tab and map the device to the desired tank
position.

10. Click the Next button to proceed with the Rosemount 5900 configuration.

11. In the 5900 RLG Summary window, click the Finish button to verify the
configuration and finish the installation wizard. In case some part of the
configuration needs to be changed, click the Back button until the desired window
appears.

Postrequisites

Verify that the device communicates with the Rosemount 2410 Tank Hub. Use for
example the tank hub’s Device Live List function to see all devices connected to the tank
hub. The live list is available by right clicking the tank hub’s device icon.

Further configuration options are available in the 5900 RLG Properties window.

Related information

Installing a Rosemount 5900 Radar Level Gauge
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Configuration via the Properties window
Advanced configuration
Installing a Rosemount 2460 System Hub
Installing a Rosemount 2410 Tank Hub
Tank Database setup
Rosemount 5900S Reference Manual
Rosemount 5900C Reference Manual
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2.8 Installing the Rosemount 5900S 2-in-1version
Installing a 2-in-1 Rosemount 5900S Radar Level Gauge is in most parts similar to installing
a standard 5900S. A significant difference though, is that in the TankMaster operator’s
interface the Rosemount 5900S 2-in-1 version will be configured as two separate gauges,
and each gauge will be associated with its own tank.

2.8.1 Overview
To install and configure a 2-in-1 version of the Rosemount 5900S level gauge:

Procedure

1. In Rosemount TankMaster WinSetup, configure the Rosemount 2460 System Hub’s
tank database by adding two Rosemount 5900S gauges.

2. In Rosemount TankMaster WinSetup, install the Rosemount 2410 Tank Hub.

3. Configure the new tank hub’s tank database:

a) map the two Rosemount 5900S gauges to two different tank positions, i.e.
configure the Primary and Secondary gauges as if they are installed on two
different tanks

b) assign a Level Modbus® address for each Rosemount 5900S

4. Assign tags for the Rosemount 5900S Radar Level Devices and the Auxiliary Tank
Device(5) (ATD). The ATD includes various non-level devices such as temperature
transmitters, displays, and pressure transmitters.

5. Install the devices in the TankMaster workspace. This is done automatically by the
installation wizard for the Rosemount 2410 in case the Install Level and AUX
devices check box is selected in the Rosemount 2410 Tank Hub Summary window.

6. Configure the level gauges and ATD devices (right-click the device icon and select
Properties).

7. Install two new tanks to be associated with the primary and secondary Rosemount
5900S radar level gauges.

8. Assign a Rosemount 5900S and an ATD for the primary tank.

9. Assign a Rosemount 5900S for the secondary tank. Note that the primary and
secondary tanks in TankMaster workspace represent one tank in real life.

10. Configure the tanks.

11. Open the TankMaster workspace to verify correct installation of tanks and devices.

Related information

Installing a Rosemount 2410 Tank Hub

(5) Auxiliary Tank Device (ATD) is used in the Tank Database of the Rosemount 2410 Tank Hub to designate various devices
such as temperature and pressure transmitters, displays and other non-level devices.
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Configuration example of Rosemount 5900S 2-in-1
The Rosemount 5900S 2-in-1 version is installed and configured in TankMaster as a tank
gauging system with two tanks. Various configuration options are possible:

1. Primary tank with 5900S and ATD (2240S, 2230 ...). Secondary tank with 5900S.

2. Primary tank with 5900S and ATD (2240S, 2230 ...). Secondary tank with 5900S.
ATD on Primary tank mapped to secondary tank (see Figure 2-8).

3. Primary tank with 5900S and ATD (2240S, 2230...). Secondary tank with 5900S and
redundant ATD.

Figure 2-8: Example of a Rosemount 5900S 2-in-1 System

A

B
C

A. Rosemount 5900S 2-in-1 on Primary tank
B. Rosemount 5900S 2-in-1 on Secondary tank
C. Rosemount 2240S: mapped from primary tank
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2.8.2 Installation and configuration
To install and configure the 2-in-1 version of the Rosemount 5900S, follow these steps:

Procedure

1. Start the TankMaster WinSetup program.

2. Configure the Rosemount 2460 System Hub’s tank database. Since the Rosemount
5900S 2-in-1 version includes two separate gauges, you will have to add two Level
Device addresses in the Tank Database.

3. Assign Modbus® addresses for the Rosemount 5900S 2-in-1 level devices.

A. Primary tank
B. Secondary tank

Example

Primary tank TK-1: address=1

Example

Secondary tank TK-1S: address=51

• It is recommended that Modbus address 50 + “X” is used for the secondary level
device, where “X” is the address of the primary level device.

• For the Primary tank the temperature device will automatically be assigned the
same Modbus address as the Rosemount 2410 Tank Hub.

• For the Secondary tank you will not need to enter a “Temp Device Address”.

• Do not configure any temperature elements (Number of Temp Elements=0) for
the Secondary temperature device.

In case two temperature transmitters are installed on the tank, one to be associated
with the Primary and the other to the Secondary tank, you will need to configure
Temp Device Address as well as Number of Temp Elements for both tanks. This
configuration is like a standard configuration with one Rosemount 2410 connected
to two separate tanks.
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4. Proceed with installing a Rosemount 2410 Tank Hub. In the WinSetup workspace,
select the Devices folder, click the right mouse button and select File → Install
New:

5. In the Select Device window, select Device Type 2410 Tank Hub and assign a 2410
Tag.

6. Click the Next button to proceed to the Tank Database configuration window.
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7. Configure the tank hub’s tank database:

A. Primary level gauge on TK-1
B. Secondary level gauge on TK-1S

In the tank database, the Rosemount 5900S 2-in-1 will appear as two separate level
gauges. The two gauges are mapped to different tank positions and will be
associated with different tanks in the WinSetup workspace.

Example

Assign the same name on the two tanks. Add “S” to the secondary tank name, for
example:

primary tank: TK-1

secondary tank: TK-1S

Assign Level Modbus Addresses to the gauges. Example:

TK-1: 1

TK-1S: 51

It is recommended that Modbus address 50 + “X” is used for the secondary device,
where “X” is the address of the primary radar level gauge.

Ensure that the same addresses are configured in the tank databases for the
Rosemount 2460 System Hub and the Rosemount 2410 Tank Hub, respectively.

8. Click Next to proceed to the Device Tags window.
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9. Verify Level Tags for the primary and secondary Rosemount 5900S gauges, and
ATD Tags for the other devices (temperature transmitter, field display, pressure
transmitter). The tags can be changed later if needed.
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10. In the final step of the Rosemount 2410 installation wizard, check that all device
tags and Modbus addresses are correct. Note that if a Rosemount 2460 System Hub
is used, the Modbus addresses in the Rosemount 2410’s tank database must match
the addresses configured in the Rosemount 2460’s tank database.

Ensure that the Install Level and ATD devices... check box is selected in case you
like to enable automatic installation of devices in the TankMaster workspace. This is
the recommended setting.

Note
If new devices are added to an existing Rosemount 2410 Tank Hub, the Install Level
and ATD devices check box may not be active. Then you will have to add the new
devices manually.
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11. Verify that the devices appear in the WinSetup workspace. The Rosemount 2410
Tank Hub, the two Rosemount 5900S RLGs, and the ATD are automatically installed
in the TankMaster WinSetup workspace if the check box is marked in the 2410 Tank
Hub Summary window.

Note
The new device icons are red indicating that these devices need to be configured.

Once the tank hub and associated level and ATD devices are installed in TankMaster
you will have to configure each device.

12. Configure the level gauges and ATD devices (right-click the device icon and select
Properties).

13. Finally, when devices are installed and configured you will have to install and
configure the two tanks to be associated with the 2-in-1 Rosemount 5900S. In the
following description one tank will be associated with the primary level gauge (LT-
TK-1 in this example), and the other tank will be associated with the secondary level
gauge (LT-TK-1S).

a) Select the Tanks folder.

b) Click the right mouse button and select the Install New option.

c) Install and configure the primary tank first and then the secondary tank.
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14. For each tank, select Tank Type and assign a Tank Tag. It is recommended that you
use the same tank name as specified in the tank database of the Rosemount 2410
Tank Hub.

15. Assign devices to the primary tank TK-1:

a) Primary Rosemount 5900S level gauge (LT-TK-1)

b) ATD device (ATD-TK-1) in case the tank is equipped with non-level devices
such as a Rosemount 2240S Temperature Transmitter, a Rosemount 2230
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Graphical Field Display, Water Level Sensor, or a Rosemount 3051S Pressure
Transmitter.
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16. For the secondary tank TK-1S assign the secondary 5900S level gauge (LT-TK-1S) as
shown below:
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17. Optional: You may map the ATD device on the primary tank to the secondary tank
TK-1S as shown below. This allows you to view temperature data, such as Average
Temperature, for the secondary tank as well.

Note
You need to ensure that Show Only Vacant Devices is not selected in order to view
all devices.
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18. Choose the desired tank measurement variables. For the primary tank, variables
associated with the ATD device automatically appears in the Configuration window.

Note
The available source variables may vary depending on the actual devices connected
to the Rosemount 2410 Tank Hub.

For the secondary tank, “none” is automatically selected for temperature and
pressure variables as well as for free water level. In case the ATD device on the
primary tank is mapped to the secondary tank as well, those variables will appear in
the Configuration window for the secondary tank.

Device installation Reference Manual
February 2022 00809-0300-5100

84 Emerson.com/Rosemount



19. Specify parameter Value Range (Minimum, Maximum) to be used in various
windows for presentation of measurement data.

Note
Calculation of the Average Temperature (AVG Temp) requires a valid Level value. In
case the Level value is not available, the Average Temperature (AVG Temp) will also
be missing.

20. Configure whether to use measurement values (Automatic) from the available
instruments or Manual values.
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21. In the TankMaster WinSetup workspace verify that the tanks and devices are
properly installed. Check that the two Rosemount 5900S gauges and the ATD are
associated with the right tanks. Two options are shown below:

• ATD (temperature transmitter, etc.) is associated with the primary tank only

• ATD on primary tank is mapped to both the primary and secondary tanks

Example

ATD mapped to Primary tank only

Example

ATD mapped to both the primary and secondary tank

Device installation Reference Manual
February 2022 00809-0300-5100

86 Emerson.com/Rosemount



Related information

Installing a Rosemount 5900 Radar Level Gauge
Installing Auxiliary Tank Devices
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2.9 Installing Auxiliary Tank Devices
Auxiliary Tank Devices (ATDs) such as the Rosemount 2240S Multi-input Temperature
Transmitter and the Rosemount 2230 Graphical Field Display, are typically installed as part
of the installation procedure of the Rosemount 2410 Tank Hub.

ATD devices appear in the TankMaster workspace and are configured via the 22XX ATD
window. The 22XX ATD window includes tabs for configuration of temperature sensors,
graphical field displays, and water level sensors. It also includes configuration options for
mapping outputs of measurement instruments to variables such as Free Water Level and
Liquid Pressure. Before starting the ATD installation, read the reference manuals for the
various ATD devices, such as the Rosemount 2240S and the Rosemount 2230, to learn
more about how to configure these devices.

2.9.1 Opening the Properties window

Procedure

1. In the WinSetup Workspace window, open the Devices folder and select the ATD
icon.

2. Click the right mouse button and select Properties, or from the Service menu select
Devices  → Properties.

3. The 22XX ATD window has a number of configuration tabs for the Rosemount
2240S and the Rosemount 2230.

4. Open the appropriate tabs to configure the ATD devices.

5. Finish the ATD configuration by clicking the Apply or OK button.
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2.9.2 Communication parameter setup
The Communication tab lets you verify the device communication settings. A red icon
means that the current ATD needs to be configured.

Procedure

1. In the 22xx ATD window select the Communication tab.

2. In the Connected to HUB field, verify that the ATD device is:

• connected to the correct Rosemount 2410 Tank Hub

• mapped to the correct position in the tank hub’s tank database

For example, “position 1” means that the ATD device is mapped to tank database
position 1 in the tank hub’s database, “position 2” to tank database position 2 etc.
You can check the tank database of the current tank hub by opening the 2410 HUB
Properties/Tank Database window.

3. The Change button lets you change the Modbus® address of the current ATD device
in case it is connected to a multiple tank version of the tank hub. Note that the
Modbus address can only be changed for ATD devices in tank database position 2
and higher. An ATD device mapped to position 1 in the tank hub’s database uses
the same Modbus address as the tank hub itself.

4. Click the Apply button to store the configuration, or click the OK button to store
the configuration and close the window.

Related information

Installing a Rosemount 2410 Tank Hub
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2.9.3 Temperature sensor configuration
The 2240S MTT Temperature Sensor tab lets you configure a sensor connected to the
Rosemount™ 2240S Multi-input Temperature Transmitter. The 2240S MTT Temperature
Sensor tab input fields are disabled in case no Rosemount 2240S is connected to the
Tankbus.

Procedure

1. In the 22xx ATD window, select the 2240S MTT Temperature Sensor tab.

2. The Rosemount 2240S is equipped with a DIP switch for automatic configuration of
temperature element and wiring. By selecting the Use Auto Sensor Configuration
check box, the transmitter is automatically configured according to the DIP switch
settings.

In case a temperature element type is used that does not match the Auto Sensor
Configuration, the Rosemount 2240S transmitter can be manually configured.

Related information

Temperature sensor manual configuration
Rosemount 2240S Reference Manual
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Temperature sensor manual configuration

Procedure

1. Ensure that the Use Auto Sensor Configuration check box is unchecked.

2. In the Method input field, select the desired user defined conversion method.

Note
For spot temperature elements, use the Pt100 sensor option to ensure correct
average temperature calculation.

3. In the Connection drop-down list, choose the type of sensor connection that is used
for the spot sensors.

4. Specify the measurement range of the current temperature element in the Min
Value and Max Value input fields.

5. For user defined temperature conversion, such as User defined table, User defined
formula, and User defined individual formula, click the configuration button that
corresponds to the selected conversion method and configure the temperature
sensors.

6. Click the Apply button to store the configuration, or click the OK button to store
the configuration and close the window.

Related information

Rosemount 2240S Reference Manual
User defined linearization table
User defined formula
User defined individual formula
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User defined linearization table

When using a resistance temperature sensor, the electrical resistance values can be
converted to temperature values by using a table of resistance and temperature values.

Procedure

1. In the 2240S MTT Temperature Sensor window, select conversion method User
Defined Linearization Table.

2. Click the Configure User Defined Linearization Table button:

3. Specify the number of conversion points in the Length of Table input field.

4. Type resistance and temperatures values into the Resistance [Ohm] and
Temperature [C] columns.

5. Click the OK button to store the linearization table in the temperature transmitter’s
database registers.
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User defined formula

For a resistance temperature sensor, the relation between temperature and resistance can
be specified by a mathematical formula:

R=R0*(1+A*T+B*T2),

where R is the resistance at temperature T, R0 is the electrical resistance at zero degrees
Celsius, and A and B are constants.

Procedure

1. In the 2240S MTT Temperature Sensor window, choose conversion method User
Defined Formula.

2. Click the Configure User Defined Formula button:

3. Enter the parameters R0, A and B in the corresponding input fields.

4. Click the OK button to store the R0, A and B parameters in the temperature
transmitter’s database registers.
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User defined individual formula

When using User Defined Individual Formula, a mathematical formula is used for each
individual temperature element:

R=R0*(1+AN*T+BN*T2+CN*T3),

where

• R is the resistance at temperature T

• R0 is the resistance at zero degrees Celsius

• A, B, and C are individual constants for each element

• N is the number of temperature sensors

Procedure

1. In the 2240S MTT Temperature Sensor window, choose conversion method User
Defined Individual Formula.

2. Click the Configure User Defined Individual Formula button:

3. Enter parameters R0, A, B, and C for each individual temperature element.

4. Click the OK button to store the formula in the temperature transmitter’s database
registers.
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2.9.4 Average Temperature calculation
This section gives a brief description of how to configure average temperature calculations
for a temperature sensor connected to the Rosemount 2240S Multi-input Temperature
Transmitter.

Procedure

1. In the 22xx ATD window, select the Average Temperature Calculation tab.

2. No of Elements: select the number of temperature elements used. Verify that the
input fields for element positions are enabled.

3. Sensor Type: select the type of sensor that is used; Spot or Average.

4. Insert Distance: specify the minimum distance between a temperature sensor and
the product surface for temperature sensors included in average temperature
calculation.

5. Position: enter the distance from Zero Level to the spot temperature element. If
average temperature elements are used, enter the position where the average
element ends.

6. You may exclude a temperature element from average temperature calculation by
selecting the Exclude check box in the column next to the Position field. This option
may be useful in case you would like to exclude a malfunctioning temperature
element.

7. Click the Apply button to store the configuration, or click the OK button to store
the configuration and close the window.

Related information

Rosemount 2240S Reference Manual
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2.9.5 Auxiliary sensor configuration
The 2240S MTT Auxiliary Sensor tab lets you configure a water level sensor connected to a
Rosemount 2240S Multi-input Temperature Transmitter.

Procedure

1. In the 22xx ATD window, select the 2240 MTT Auxiliary Sensor tab.

2. Calculate the Level Offset (X) according to the formula X=(R-L1)-(L-L2).

3. Enter the resulting level offset value in the Level Offset (X) input field.

4. Enter the Upper Dead Zone (UDZ) and the Lower Dead Zone (LDZ) if needed.

5. Click the Apply button to store the configuration, or click the OK button to store
the configuration and close the window.

Related information

Rosemount 2240S Reference Manual
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2.9.6 Advanced parameter source configuration
The Advanced Parameter Source Configuration tab lets you map the output of various
measurement instruments (source devices) to tank measurement variables such as Liquid
Pressure and Vapor Pressure. This makes the measurement variables available for
configuration in the Tank Configuration window

For tank measurement variables such as Level, Vapor Temperature, and Free Water Level,
source devices are automatically mapped and do not need to be configured in the
Advanced Parameter Source Configuration tab.

The Rosemount 2410 Tank Hub supports 60 source parameter mappings. Six mappings
are reserved for each one of the ten tank database positions.

Note
A warning message will appear in case a certain parameter/source mapping is already used
for another tank.

For a source device to be available in the Advanced Parameter Source Configuration tab, it
must be mapped to the current tank in the tank hub’s database.

Procedure

1. In the 22xx ATD window select the Advanced Parameter Source Configuration tab.

2. In the Parameter Mapping column select a tank measurement parameter.

3. In the Source Device Type/ID/No column, choose a measurement device such as a
pressure transmitter or any other type of instrument.

The default setting lists only devices mapped to the current tank position in the
tank hub’s database. By using this option you will avoid mapping to a device on the
wrong tank by mistake. By selecting the appropriate radio button you can choose to
show all available devices, or only the devices mapped to tank position 1 in the
2410 tank database.

4. In the Source Parameter column, select the transmitter variable to be mapped to
the tank measurement variable in the first column.
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5. In case User Defined is selected, you may type a description in the Description of
User Def parameter box.

6. Click the Apply button to store the configuration, or click the OK button to store
the configuration and close the window.

Related information

Installing a Rosemount 2410 Tank Hub
Installing a tank
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Using a Rosemount 644 Temperature Transmitter
The Rosemount Tank Gauging system automatically handles source parameter mapping
for Rosemount 2240S transmitters to provide correct input for calculation of tank
measurement variables such as Vapor Temperature and Average Temperature.

For Rosemount 644 temperature transmitters, tank variables have to be mapped manually
to the appropriate source devices. The output from each Rosemount 644 transmitter on
the tank is mapped to a temperature tank variable as shown in the following example with
three Rosemount 644 transmitters on the tank.

Procedure

1. In the 22xx ATD window select the Advanced Parameter Source Configuration tab.

2. In the Parameter Mapping list select Temperature 1 for the first 644 temperature
transmitter. This temperature parameter is mapped to the temperature element at
position 1 in the tank.

For the second and third 644 transmitters, select Temperature 2 and Temperature
3 in the Parameter Mapping list. These parameters are mapped to the temperature
elements at position 2 and 3, respectively.

3. In the Source Device Type field, for each temperature parameter (Temperature 1,
2, 3) select the actual 644 transmitter to be used as source device.

4. In the Source Parameter list, select Temperature 1. This is the source parameter
designation of the temperature output from a Rosemount 644 temperature
transmitter.

Note
The Vapor Temperature and Average Temperature variables are not mapped to the
source devices.

5. Click the Apply button to store the configuration, or click the OK button to store
the configuration and close the window.
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2.9.7 Rosemount 2230 Graphical Field Display
This section gives a brief description of how to configure a Rosemount 2230 Graphical
Field Display.

All fields in the 2230 Graphical Field Display tab are disabled if no graphical field display is
connected to the Tankbus, or if the display is not mapped to the current tank database
position of the Rosemount 2410 Tank Hub. The Configure Tank Display 2 and Configure
Tank Display 3 buttons are disabled when only one Rosemount 2230 is mapped to the
current tank database position.

Procedure

1. In the 22xx ATD window select the 2230 Graphical Field Display tab.

2. From the drop-down lists in the Units for Display pane, select the desired
measurement units to be displayed for the various tank measurement variables.

Note
The Rosemount 2230 converts the unit specified in the Server Preferences window.

3. In the Common Tank Configuration pane, select tanks and tank parameters to be
presented by the Rosemount 2230 display by selecting the appropriate check
boxes.
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4. In the Display Toggle Time input field, enter toggle time for the displayed tank
parameters. The selected parameters will be displayed for one tank at a time
starting with Tank 1.

5. If a second graphical field display is used, click the Configure Tank Display No 2
button and repeat the configuration procedure.

6. If a third graphical field display is used, click the Configure Tank Display No 3
button and repeat the configuration procedure.

7. The Rosemount 2230 can be configured to show different set of parameters for
each tank on the Tank Bus. In the 2230 Graphical Field Display tab click the
Individual Tank Configuration button:

8. Select the desired tank and parameters to show on the Rosemount 2230 display.
Repeat this procedure for each tank.

9. Click the OK button to store the configuration and return to the 22xx ATD window.

10. Click the Apply button to store the configuration, or click the OK button to store
the configuration and close the window.

Related information

Measurement units
Rosemount 2230 Reference Manual
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2.9.8 Analog input
The Rosemount™ 2410 Tank Hub can be equipped with an analog input which lets you
connect instruments for 4- 20 mA/HART communication.

Procedure

1. In the 22xx ATD window select the Analog Input tab.

2. Ensure that the Enable check box is selected.

3. In the Value Unit field select a suitable unit to match the input source.

4. In the Value Range pane, enter the parameter values that correspond to the analog
input values 4 mA and 20 mA, respectively. You may specify any value as long as the
20 mA value is higher the 4mA value. For measurement values outside the range
values, the analog input enters alarm mode.
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5. Use the Advanced button in case you would like to configure Filter Factor and
Current Limits.

Filter
Factor

Lets you suppress spurious fluctuations in the analog input signal. A
value between 0 and 1 can be used. The default value is 0.1. A higher
value means less filtering.

Filtering means that the presented Analog Input value is calculated as
the average value of the <n> latest measurements. A filter factor equal
to 0.1 is the average of the 10 latest measurements, a filter factor
equal to 0.5 is the average of the 2 latest measurements and so on.

Current
Limits

Define the lower and upper limits of the input currents. An error will be
indicated outside this range. The current limits should correspond to
the error limits of connected instruments. If for example an instrument
sets the output current in alarm mode to 3.8 mA, you should set the
lower error limit to 3.8 or higher.

6. In the Analog Input Values pane, verify that Status is OK and that the expected
measurement results appear in the Value and Current fields.

Related information

Rosemount 2410 Reference Manual
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Analog input tank parameter setup
This is a description of the steps to perform for a complete configuration of the
Rosemount 2410 Tank Hub's analog input.

Procedure

1. Configure the tank hub’s tank database; associate the Analog Input with the tank
on which the device is installed.

2. In the Rosemount 2410 Properties window, select the Device Tags tab and install the
analog input device in TankMaster. Verify that it is installed as an ATD device.

3. In the ATD Properties/Analog Input window, configure value range and units.

4. In the ATD Properties/Advanced Parameter Source Configuration window, ensure that
the analog input device is mapped to the desired tank parameter, source device,
and source parameter.

5. Install a tank in TankMaster WinSetup and make sure that the ATD device that
includes the analog input device is mapped as source device for the tank.

Postrequisites

See the Rosemount 2410 Reference Manual for more information on how to set up the
analog input.
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2.10 Installing a Rosemount 5408
The Rosemount 5408 Radar Level Transmitter is most conveniently installed in
TankMaster WinSetup, by utilizing the integrated option included as part of the
Rosemount 2410 Tank Hub installation procedure. Once installed, the Rosemount 5408 is
configured via the 5408 RLT window which includes tabs for basic and advanced
configuration.

When connecting a Rosemount 5408 to a Rosemount 2410 Tank Hub in an existing
Rosemount Tank Gauging system, the Rosemount 5408 has to be mapped to the
appropriate tank in the Rosemount 2410 tank database. Configuration is performed via
the 5408 RLT window.

A Rosemount 5408 can also be installed and configured by using the WinSetup installation
Wizard. This method should only be used when, for example, the transmitter is connected
to the Tankbus at a later stage and not available when installing the Rosemount 2410 Tank
Hub.

The following configuration steps are included in the Rosemount 5408 radar level
transmitter basic configuration:

• communication parameters

• antenna type

• tank geometry

Due to properties of the product, tank shape, or other circumstances, further
configuration may be needed in addition to the basic configuration. Disturbing objects
and turbulent conditions in the tank may also require advanced measures to be taken. The
TankMaster WinSetup configuration tool includes advanced options for the 5408 such as:

• tank environmental conditions

• tank shape

Related information

Configuration via Properties window
Install a Rosemount 5408 using the installation wizard
Rosemount 5408 Reference Manual FF
Rosemount 5408 Reference Manual HART
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2.10.1 Configuration via Properties window
This section describes the basic configuration procedure for a Rosemount 5408 Radar
Level Transmitter by using the 5408 RLT window.

Procedure

1. In the WinSetup Workspace window, open the Devices folder and select the
Rosemount 5408 transmitter icon.

2. Click the right mouse button and select Properties, or from the Service menu select
Devices  → Properties.

3. Select the Communication tab. Note that a red gauge icon means that the device
needs to be configured.
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4. Verify the tank position.

The Connected to 2410 HUB field shows the name of the Rosemount 2410 Tank Hub
and the tank position that the device is mapped to in the tank hub’s database. The
tank position indicates which tank the device is associated with.

In most cases, the Rosemount 2410 single tank version is used for level gauges. In
those cases, only one tank position will be used in the tank hub’s database.

In case the multiple tank version of the Rosemount 2410 is used to connect several
tanks, the level gauge can be mapped to another tank through the 2410 Tank Hub
Properties/Tank Database window:

a) in the WinSetup workspace click the right mouse button on the Rosemount
2410 icon.

b) select Properties and open the Tank Database tab.

c) select the desired tank position.

5. Verify that the Modbus® address is correct. To change the address:

a) Click the Change button to open the Communication window.

b) Click the Change Address on Device button to open the Change Address
window:

c) Enter the Unit ID. When changing the device address, the Unit Id is used as a
unique identifier of the device. The Unit Id can be found on the main label.

d) Set the desired Modbus address.

e) Click OK to confirm the settings and close the Change Address window.

f) Click OK to close the Communication window.

6. In the 5408 RLT Communication window click the Apply button to store the address.
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7. Select the Antenna tab:

8. Select Antenna Type and mounting type if applicable. You may choose between
predefined antenna types or user defined for non-standard antennas. For
predefined antennas a number of transmitter parameters are automatically
specified in order to optimize measurement performance. For user defined antenna
the database settings must be entered manually.

Enter Antenna Extension Length in case the antenna is equipped with an
extension.

9. In case there are disturbances close to the nozzle you may adjust the Upper Null
Zone. By increasing the Upper Null Zone, the measurement range is reduced in the
upper part of the tank.

10. For still pipe applications enter the Inner Diameter.

11. Click the Apply button to save the configuration.
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12. Select the Geometry tab:

13. Enter the tank geometry parameters.

Tank
Reference
Height (R)

Distance from the Tank Reference Point to the Zero Level.

Reference
Offset (G)

Distance between the Tank Reference Point and the Gauge
Reference Point, which is located at the surface of the nozzle
flange on which the gauge is mounted.

Bottom
Offset (C)

Distance between the Zero Level (Dipping Datum Point) and the
minimum level for the product surface (tank bottom). By
specifying a C-distance, the measuring range can be extended to
the bottom of the tank.
C>0: the transmitter presents negative level values when the
product surface is below the Zero Level (Datum plate). You can
use the Show negative level values as zero check box to present
product levels below the Zero Level as equal to zero.

C=0: measurements below the Zero Level will not be approved,
i.e. the transmitter will report “invalid level” if the product level is
below the Zero Level.

14. Enter Calibration Distance if needed. This variable lets you adjust the tank height so
that measured product levels correspond to hand dipped levels. Normally a minor
adjustment is necessary when the transmitter is installed. For example, a minor
deviation between the actual tank height and the value stored in the transmitter
database may occur if tank dimensions according to drawings are not quite up to
date with actual dimensions.
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15. Optional: Select the Show negative level as zero check box in case you don’t want
the transmitter to show negative level values.

16. Click the Apply button to store the configuration, or click the OK button to store
the configuration and close the window.

Related information

Installing a Rosemount 5408
Advanced configuration
Tank Database setup
Rosemount 5408 Reference Manual FF
Rosemount 5408 Reference Manual HART
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2.10.2 Advanced configuration
In addition to the basic configuration there are advanced configuration options available
for the Rosemount 5408 transmitter. This section provides a brief description of a couple
of these options. For more information on advanced configuration see the Rosemount
5408 Series Reference Manual.

Tank shape

The Tank Shape and Bottom Shape parameters optimize the Rosemount 5408 for various
tank geometries and for measurements close to the tank bottom. These parameters are
configured in the Tank Shape window:

Figure 2-9: Tank Shape Window
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Tank environment

Certain product conditions in the tank may require special configuration options to be
used in order to optimize measurement performance of the 5408 Radar Level Transmitter.
By configuring the environmental conditions in the tank, the transmitter can compensate
for conditions such as rapid level change, weak echo signals, varying surface echo
amplitudes, or other similar sources of inaccurate measurement.

The Environment window is used to optimize the transmitter for special tank conditions.
For Process Conditions it is recommended to select as few options as possible.

Figure 2-10: Environment Window

Related information

Installing a Rosemount 5408
Rosemount 5408 Reference Manual FF
Rosemount 5408 Reference Manual HART
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2.10.3 Install a Rosemount 5408 using the installation wizard
The installation wizard in TankMaster WinSetup is a tool that may be used to install and
configure various devices in a Rosemount Tank Gauging system.

Prerequisites

Ensure that the tank databases of the Rosemount 2460 System Hub and the Rosemount
2410 Tank Hub are properly configured and include the new device.

Ensure that the correct Modbus® address is used.

Field devices are typically installed as part of the installation procedure for a Rosemount
2410 Tank Hub. However, the installation wizard lets you install devices in TankMaster
separately from the tank hub installation.

Procedure

1. In the Workspace window select the Devices folder.

2. Click the right mouse button and select Install New, or from the Service menu
select Devices → Install New.
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3. Select Device Type 5408 Radar Level Transmitter from the drop-down list.

4. Enter the desired tag for identifying the device.

5. Click the Next button to open the 5408 RLT Communication window:

6. In the 2410 HUB Tag drop-down list, select the tank hub that the Rosemount 5408
Radar Level Transmitter is connected to. Normally, there is one tank hub for each
tank.

7. Enter the Modbus address. This address must be available in the tank databases of
the Rosemount 2460 System Hub and the Rosemount 2410 Tank Hub.

8. Click the Verify Communication button to verify that the TankMaster PC
communicates with the device. The Unit ID will appear when contact is established.

9. Check the Position in 2410 HUB field to verify that the device is mapped to the
correct tank position in the Rosemount 2410 tank database. The tank position
indicates which tank the device is associated with. Normally, the single tank version
of the Rosemount 2410 Tank Hub is used for level gauges. In those cases the
Position in 2410 HUB field will be equal to 1 since there is only one tank position
that is used in the tank hub's database.

In case the multiple tank version of the Rosemount 2410 Tank Hub is used for
several tanks, the level gauge can be mapped to the desired tank via the 2410 Tank
Hub Properties/Tank Database window:

a) In the WinSetup workspace, click the right mouse button on the tank hub
icon.

b) Select the Properties option.

c) Select the Tank Database tab and map the device to the desired tank
position.

10. Click the Next button to proceed with the Rosemount 5408 configuration.
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For more information refer to the appropriate parts in chapter Configuration via
Properties window.

11. In the 5408 RLT Summary window, click the Finish button to verify the configuration
and finish the installation wizard. In case some part of the configuration needs to be
changed, click the Back button until the desired window appears.

12. Verify that the device communicates with the Rosemount 2410 Tank Hub. Use for
example the tank hub’s Device Live List function to see all devices connected to the
tank hub. The live list is available by right clicking the tank hub’s device icon.

Postrequisites

Further configuration options are available in the 5408 RLT Properties window.

Related information

Configuration via Properties window
Advanced configuration
Installing a Rosemount 5408
Tank Database setup
Rosemount 5408 Reference Manual FF
Rosemount 5408 Reference Manual HART

Reference Manual Device installation
00809-0300-5100 February 2022

Rosemount Tank Gauging 115

https://www.emerson.com/documents/automation/5568230.pdf
https://www.emerson.com/documents/automation/202470.pdf


2.11 Installing a Rosemount 5300
The Rosemount 5300 Radar Level Transmitter is most conveniently installed in
TankMaster WinSetup, by utilizing the integrated option included as part of the
Rosemount 2410 Tank Hub installation procedure. Once installed, the Rosemount 5300 is
configured via the 5300 RLT window which includes tabs for basic and advanced
configuration.

When connecting a Rosemount 5300 to a Rosemount 2410 Tank Hub in an existing
Rosemount Tank Gauging system, it has to be mapped to the appropriate tank in the
Rosemount 2410 tank database. Configuration is performed via the 5300 RLT window.

A Rosemount 5300 can also be installed and configured by using the WinSetup installation
Wizard. This method should only be used when, for example, the transmitter is connected
to the Tankbus at a later stage and not available when installing the Rosemount 2410 Tank
Hub.

The following configuration steps are included in the Rosemount 5300 radar level
transmitter basic configuration:

• communication parameters

• probe type

• tank geometry

Due to properties of the product, tank shape, or other circumstances, further
configuration may be needed in addition to the basic configuration. Disturbing objects
and turbulent conditions in the tank may also require advanced measures to be taken. The
TankMaster WinSetup configuration tool includes advanced options for the 5300 such as:

• tank environmental conditions

Related information

Configuration via Properties window
Install a Rosemount 5300 using the installation wizard
Rosemount 5300 Reference Manual

2.11.1 Configuration via Properties window
This section describes the basic configuration procedure for a Rosemount 5300 Guided
Wave Radar by using the 5300 GWR window.

Procedure
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1. In the WinSetup Workspace window, open the Devices folder and select the
Rosemount 5300 transmitter icon.

2. Click the right mouse button and select Properties, or from the Service menu select
Devices  → Properties.

3. Select the Communication tab. Note that a red gauge icon means that the device
needs to be configured.
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4. Verify the tank position.

The Connected to 2410 HUB field shows the name of the Rosemount 2410 Tank Hub
and the tank position that the device is mapped to in the tank hub’s database. The
tank position indicates which tank the device is associated with.

In most cases, the Rosemount 2410 single tank version is used for level gauges. In
those cases, only one tank position will be used in the tank hub’s database.

In case the multiple tank version of the Rosemount 2410 is used to connect several
tanks, the level gauge can be mapped to another tank through the 2410 Tank Hub
Properties/Tank Database window:

a) in the WinSetup workspace click the right mouse button on the Rosemount
2410 icon.

b) select Properties and open the Tank Database tab.

c) select the desired tank position.

5. Verify that the Modbus® address is correct. To change the address:

a) Click the Change button to open the Communication window.

b) Click the Change Address on Device button to open the Change Address
window.

c) Enter the Unit ID. When changing the device address, the Unit Id is used as a
unique identifier of the device. The Unit Id can be found on the main label.

d) Set the desired Modbus address.

e) Click OK to confirm the settings and close the Change Address window.

f) Click OK to close the Communication window.

6. In the Communication window click the Apply button to store the address.
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7. Select the Probe tab:

8. Select a Probe Type that corresponds to the actual probe that is used on the
transmitter. You may select a predefined (standard) probe, or User Defined for non-
standard probes. For predefined probe types, measurement performance is
optimized by automatically specifying various device parameters. For a User
Defined probe the database settings must be configured manually.

The following predefined (standard) Probe Types are available:

• Flexible Twin

• Flexible Single

• Coaxial

9. Probe Length is measured from the Upper Reference Point to the end of the
probe. If a weight is used at the end of the probe it shall not be included.

10. Adjust the Hold Off Distance (UNZ) if there are disturbances in the upper part of
the tank. Such problems may occur if there are disturbing objects, such as a narrow
nozzle with rough walls, close to the probe. By increasing the Hold Off distance, the
measuring range is reduced.

11. Click the Apply button to save the configuration.
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12. Select the Geometry tab:

13. Tank Reference Height (R) is defined as the distance from the Upper Reference
Point to the Zero Reference Point.

14. Reference Distance (G) is the distance between the Upper Reference Point and the
flange.

15. Use the Calibration Distance parameter to adjust the tank height so that measured
product levels match the hand dipped level values. Typically a minor adjustment is
necessary when the device is installed. For example, a minor deviation between the
actual tank height and the value stored in the device database may occur if tank
dimensions according to drawings are not quite up to date with actual dimensions.

16. Select the appropriate Mounting Type; Pipe Chamber, Direct Bracket, or Nozzle.
Select Unknown if none of these is appropriate. Depending on mounting type you
may also need to specify other parameters such as Inner Diameter and Nozzle
Height.

17. Optional: Select the Show level below probe end as zero check box if you want the
transmitter to present zero instead of negative product levels.

18. Click the Apply button to store the configuration, or click the OK button to store
the configuration and close the window.

Related information

Installing a Rosemount 5300
Advanced configuration
Tank Database setup
Rosemount 5300 Reference Manual
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2.11.2 Advanced configuration
In addition to the basic configuration there are advanced configuration options available
for the Rosemount 5300 Guided Wave Radar. Environment conditions such as rapid level
changes and dielectric constants of products as well as vapor dielectric constant can be
configured. The 5300 GWR/Environment window can be used to optimize the Rosemount
5300 for special tank conditions.

Procedure

1. In the WinSetup Workspace window, open the Devices folder and select the
Rosemount 5300 transmitter icon.

2. Click the right mouse button and select Properties, or from the Service menu select
Devices  → Properties.

3. Select the Environment tab.

4. Configure the appropriate options.

Related information

Installing a Rosemount 5300
Rosemount 5300 Reference Manual

Measurement mode
The Rosemount 5300 is preconfigured according to the specified model and normally the
measurement mode does not need to be changed.

Rapid level change
Select the Rapid Level Change check box if the surface is moving quickly up or down at
rates over 0.1 m/s (4 inch/s).
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Dielectric constant and dielectric range
The Product Dielectric Range is used for setting the appropriate signal amplitude
thresholds in order to filter out noise from the measurement signal.

The Product Dielectric Range is used for setting the appropriate signal amplitude
thresholds in order to filter out noise from the measurement signal.

In interface level measurements, dielectric constants can be configured for both the upper
and the lower products. For the Product Dielectric Range choose option Unknown if the
correct value range is not known or if the contents of the tank is changing on a regular
basis.

For measurement mode Liquid Product Level enter the Product Dielectric Range. In some
applications there is heavy vapor above the product surface having a significant influence
on the level measurement. This may for example be the case of saturated water vapor
under high pressure. In such cases the Vapor Dielectric Constant can be changed to
compensate for this effect. Normally this value does not have to be changed since the
effect on measurement performance is very small for most vapors. The default value is
equal to 1 which corresponds to the dielectric constant of vacuum.

For measurement mode Product Level and Interface Level enter the Upper Product
Dielectric Constant. If the dielectric constant of the lower product is significantly smaller
than the dielectric constant of water you may need to adjust the Lower Product Dielectric
Range as well.
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2.11.3 Install a Rosemount 5300 using the installation wizard
The installation wizard in TankMaster WinSetup is a tool that may be used to install and
configure various devices in a Rosemount Tank Gauging system.

Prerequisites

Ensure that the tank databases of the Rosemount 2460 System Hub and the Rosemount
2410 Tank Hub are properly configured and include the new device.

Ensure that the correct Modbus® address is used.

Field devices are typically installed as part of the installation procedure for a Rosemount
2410 Tank Hub. However, the installation wizard lets you install devices in TankMaster
separately from the tank hub installation.

Procedure

1. In the Workspace window select the Devices folder.

2. Click the right mouse button and select Install New, or from the Service menu
select Devices → Install New.
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3. Select Device Type 5300 Guided Wave Radar from the drop-down list.

4. Enter the desired tag for identifying the device.

5. Click the Next button to open the 5300 GWR Communication window:

6. In the 2410 HUB Tag drop-down list, choose the tank hub that the Rosemount 5300
Radar Level Transmitter is connected to. Normally, there is one tank hub for each
tank.

7. Enter the Modbus address. This address must be available in the tank databases of
the Rosemount 2460 System Hub and the Rosemount 2410 Tank Hub.

8. Click the Verify Communication button to verify that the TankMaster PC
communicates with the device. The Unit ID will appear when contact is established.

9. Check the Position in 2410 HUB field to verify that the device is mapped to the
correct tank position in the Rosemount 2410 tank database. The tank position
indicates which tank the device is associated with. Normally, the single tank version
of the Rosemount 2410 Tank Hub is used for level gauges. In those cases the
Position in 2410 HUB field will be equal to 1 since there is only one tank position
that is used in the tank hub's database.

In case the multiple tank version of the Rosemount 2410 Tank Hub is used for
several tanks, the level gauge can be mapped to the desired tank via the 2410 Tank
Hub Properties/Tank Database window:

a) In the WinSetup workspace, click the right mouse button on the tank hub
icon.

b) Select the Properties option.

c) Select the Tank Database tab and map the device to the desired tank
position.

10. Click the Next button to proceed with the configuration.
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11. Verify the configuration and click the Finish button to finish the installation wizard.
In case part of the configuration needs to be changed, click the Back button until
the desired window appears.

12. Verify that the device communicates with the Rosemount 2410 Tank Hub. Use for
example the tank hub’s Device Live List function to see all devices connected to the
tank hub. The live list is available by right clicking the tank hub’s device icon.

Postrequisites

Further configuration options are available in the 5300 GWR Properties window.

Related information

Configuration via Properties window
Advanced configuration
Installing a Rosemount 5300
Tank Database setup
Rosemount 5300 Reference Manual
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3 Tank installation
This section describes how to install and configure tanks in a Rosemount Tank Gauging
system by using the Rosemount TankMaster WinSetup configuration program.

3.1 Installing a tank

3.1.1 Overview

Basically the purpose of the tank installation procedure is to associate various devices to
the right tanks. It also includes mapping variables such as Free Water Level and Vapor
Pressure to specific instrument outputs.

Figure 3-1: Tanks folder in WinSetup workspace

Installing a new tank is a simple and straightforward procedure when using the tank
installation wizard.

Note
Make sure that measurement units are specified before installing a new tank.

Specified measurement units only affect installation of new tanks. Changing
measurement units has no effect on tanks which are already installed in WinSetup. This
means that if you want to change measurement units for an installed tank, it has to be
uninstalled first, and then installed again after changing the measurement units in the
Server Preferences/Units window.
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Steps to install a tank

1. Specify tank type: Fixed Roof, Floating Roof, Sphere, Horizontal etc.

2. Select which devices to associate with the tank.

3. Configure the tank. For inventory calculations you will need to specify source signals
for Free Water Level (FWL), Vapor Temperature, Vapor Pressure and Liquid
Pressure.

4. Specify input for the different tank variables: automatic (measured by a field device)
or manual values.

Related information

Measurement units
Advanced parameter source configuration
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3.1.2 Installing a new tank
To install and configure a tank by using the WinSetup installation wizard:

Procedure

1. Start the TankMaster WinSetup program.

2. In the Workspace window select the Tanks folder.

3. Click the right mouse button and select Install New, or from the Service menu
select Tanks → Install New.

4. Select the appropriate Tank Type from the drop-down list.

5. Enter the desired Tank Tag for identification of the tank. A prefix appears
automatically if you have defined one in the Tag Prefixes window. It is recommended
that the same name is used as in the tank database of the Rosemount 2410 Tank
Hub.
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6. Click Next to proceed with assigning field devices to the current tank:

a) From the Available Devices pane, select a device that is installed on the
current tank and click the arrow button to move it to the Selected Devices
pane.

b) Repeat this procedure for each device to be associated with the tank.

Note
It is recommended that devices are installed prior to installing tanks.

7. Click the Next button to proceed with tank configuration.

The Tank Configuration window lets you enable tank measurement variables such as
Vapor Temperature, Vapor Pressure, Liquid Pressure, and Free Water Level (FWL)
for calculating Observed Density and other inventory parameters.
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The Calculate in TankMaster check box may be used for devices without internal
calculation of Level Rate. By selecting this check box the Level Rate is calculated by
the TankMaster program

Liquid Pressure and Vapor Pressure are not automatically mapped to
measurement instruments. These tank measurement variables have to be mapped
to an instrument in the Advanced Parameter Source Configuration window in order to
make them available in the Tank Configuration window.

The Advanced button opens the Advanced Tank Setup window which allows you to
change mapping of tank measurement variables to gauge output. This option can
be used, for example, to map the relay outputs of a Rosemount 2410 Tank Hub to
relay status presentation in the TankMaster WinOpi program.

Note
Advanced configuration should only be used when there is no appropriate option
available in the standard Tank Configuration window.

8. Click the Next button to open the Value Entry window which lets you:

• Choose whether to use automatic measurement values from available
measurement instruments, or manual values.

• For desired parameters, for example Level and Free Water Level, specify
parameter Value Range to be used in various windows for presentation of
measurement data.

Some parameters, such as Free Water Level, Liquid Pressure, and Vapor Pressure,
are set to Value Source=Manual by default. Therefore, for those instruments you
need to configure automatic measurements if required.

The Value Entry window allows you to disable automatic measurements for selected
parameters in case you need to remove an instrument for service purposes.

To use manual values do the following:
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a) Select a measurement variable in the Parameters list on the left-hand side of
the Value Entry window.

b) Set Value Source to Manual.

c) Type the desired value in the Value entry field.

Manual values are marked yellow in order to distinguish them from automatic
values.

9. Specify Value Range if needed.

The Value Range parameters (Minimum and Maximum) allow you to scale bar
graphs in the Tank View window and other windows (in WinSetup as well as WinOpi)
where bar graphs are used to display product levels.

For example, the Value Range Maximum value for Level is normally set equal to the
Tank Reference Height (R), or the maximum level in the strapping table, to obtain
correct scaling of the level bar graphs.

Example

Figure 3-2: Tank View with Various Value Range Settings

A. Value range: Min=0, Max= 20 m
B. Value range: Min=0, Max= 12 m
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10. Click the Next button to open the Summary window.

The Summary window presents information about the current tank installation.
When you click the Finish button, the tank installation will be completed and the
tank appears in the WinSetup Workspace.

You can choose not to finish the installation by clicking the Cancel button. Note
that if a device was installed as part of the tank installation process, the device
remains installed and appears in the Workspace although the tank installation was
not completed.

Related information

Installation procedure
Advanced parameter source configuration
Setting the name tag prefixes
Show slave positions (advanced)
Installing a Rosemount 2410 Tank Hub

Advanced parameter source configuration
Parameters which are not automatically mapped to measurement instruments can be
mapped to an instrument in the 22XX ATD/Advanced Parameter Source Configuration
window.

Procedure

1. In the TankMaster WinSetup workspace, click the right mouse button on the ATD
device icon and select the Properties option.

2. Select the Advanced Parameter Source Configuration tab.

3. Map the appropriate tank measurement variable to the output of a transmitter on
the Tankbus. A measurement instrument which is mapped in the 22XX ATD/
Advanced Parameter Source Configuration window can be selected in the Tank
Configuration window as illustrated in Figure 3-3.
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Advanced parameter source configuration example

Figure 3-3: Example of Advanced Parameter Source Configuration

A. Liquid Pressure is mapped to a source device. In the example the source device is 3051
PT/34/(No.2).

B. In the Tank Configuration window, Liquid Pressure is mapped to the appropriate tank
parameter.
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Show slave positions (advanced)
The Show Slave Positions check box should only be used for advanced tank configuration
of devices which are not supported by the Rosemount Tank Gauging system.

A device which is connected to the Tankbus and configured in the Rosemount 2460
System Hub’s tank database, will appear in the Available Devices pane at the left-hand side
of the Select Devices window. In case a device which can not be identified by the
Rosemount Tank Gauging system is connected to the Tankbus, you will have to select the
Show Slave Positions check box in order to map this device to a tank.

Procedure

1. In the Select Devices window, select the Show Slave Positions check box to display
the tank database positions.

2. In the Select Devices window select the slave database position that corresponds to
the tank where the device is installed. In this example the devices are mapped to
position 5 which is identified as SYSHUB-201.05 in the tank database.

3. Move the selected item to the Selected Devices pane by clicking the right arrow
button.

4. Verify that the device is properly mapped to the system hub's tank database.
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Advanced tank setup
The Advanced Tank Setup window allows you to change mapping of tank measurement
variables to gauge output. This option can be used, for example, to map the relay outputs
of a Rosemount 2410 Tank Hub to relay status presentation in the TankMaster WinOpi
program.

Note
Advanced setup should only be used when there is no appropriate option available in the
standard Tank Configuration window.

Procedure

1. in the Tank Configuration window, select the Advanced button.

2. For each tank input variable you can change output as well as gauge. Simply put the
mouse pointer in the Gauge or Output field of the desired Tank Input variable
(Level, Level rate, etc.) and select the desired option from the drop-down list.

3. Click the OK button to save the configuration and close the Advanced Tank Setup
window.
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3.1.3 To change tank configuration
When a tank is installed and configured the current settings can be modified at any time
by opening the corresponding Properties dialog.

Procedure

1. Start the TankMaster WinSetup program.

2. In the Workspace window select the desired tank.

3. Click the right mouse button and select the Properties option.

4. In the Properties window, select the desired tab, and change the current tank
settings.

Basically each tab corresponds to a step in the installation wizard.

5. Click the Apply button to store the configuration before advancing to another tab.

6. Click OK to finish configuration and close the window.
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3.1.4 To uninstall a tank

Procedure

1. In the Workspace window select the tank you want to remove.

2. Click the right mouse button and select the Uninstall option from the pop-up
menu.

Related information

To uninstall a tank and associated devices
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3.2 Adding a tank
New tanks can be added to an existing Rosemount Tank Gauging system. The procedure
will be slightly different depending on the specific system configuration. Basically two
scenarios may be identified:

• Add a new tank and a Rosemount 2410 Tank Hub with all field devices that will be
installed on the tank.

• Add a new tank to an existing Rosemount 2410. This is typically a case with a tank hub
that serves multiple tanks(6).

3.2.1 Adding a new tank and a new Rosemount 2410 Tank
Hub
This section describes how to add a new tank and new field devices to a Rosemount Tank
Gauging system.

Summary
This is a brief summary of how to install a new tank and a new Rosemount 2410 Tank Hub
in a Rosemount Tank Gauging system that includes a Rosemount 2460 System Hub and
various field devices.

Procedure

1. Configure the communication settings of the Rosemount 2460 System Hub.

2. Update the system hub’s tank database by adding the field devices to be associated
with the new tank.

3. Install the new Rosemount 2410 Tank Hub and configure the tank database by
mapping field devices to the new tank.

4. Configure the field devices which have been added to the tank hub’s database
(Rosemount 5900S, Rosemount 2240S, Rosemount 3051S etc.).

(6) This requires Rosemount 2410 model code option M.
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5. Configure the new tank.

Figure 3-4: New Tank and new Tank Hub Added to the System
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Installation procedure
This is a detailed description of how to add a new tank and new field devices to a
Rosemount Tank Gauging system.

Procedure

1. Start the TankMaster WinSetup program.

2. In the WinSetup workspace, select the Rosemount 2460 System Hub icon.

3. Click the right mouse button and select Properties.

4. Select the Configuration tab.

5. In case the tank hub is connected to an unused field bus port, ensure that the port is
properly configured for the tank hub’s Primary Bus. For example, you may have to
change protocol and baud rate depending on the type of communication bus that is
used; RS -485 or TRL2.

6. Click the Apply button to save the configuration.

7. Select the Tank Database tab.

8. Configure the system hub’s tank database with Modbus® addresses for the new
Rosemount 2410 Tank Hub, level gauge, and temperature device (ATD(7)).

(7) Auxiliary Tank Device (ATD) is used to designate various devices such as temperature and pressure transmitters, displays
and other non-level devices.
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9. Install and configure a Rosemount 2410 Tank Hub and the field devices connected
to the Tankbus.

10. Install a tank and associate the new tank hub to the tank.

Figure 3-5: New Tank and Tank Hub

Related information

Installing a Rosemount 2460 System Hub
Installing a Rosemount 2410 Tank Hub
Installing a tank
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3.2.2 Adding a new tank to an existing Rosemount 2410 Tank
Hub
This section describes how to add a new tank to a Rosemount Tank Gauging system that
includes a Rosemount 2460 System Hub, a Rosemount 2410 Tank Hub, and various field
devices.

Summary
This is a brief summary of how to install a new tank in a Rosemount Tank Gauging system
by adding the tank to an existing Rosemount 2410 Tank Hub.

Procedure

1. Update the Rosemount 2460 System Hub's tank database by adding the field
devices installed on the new tank.

2. Update the existing Rosemount 2410 Tank Hub's tank database by mapping the
new field devices to the new tank.

3. Configure the field devices added to the tank hub’s database.
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4. Configure the new tank.

Figure 3-6: A New Tank is Added to an Existing 2410 Tank Hub
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Installation procedure
This is a detailed description of how to install a new tank in a Rosemount Tank Gauging
system by adding the tank to an existing Rosemount 2410 Tank Hub.

Procedure

1. Start the TankMaster WinSetup program.

2. In the WinSetup workspace, select the Rosemount 2460 System Hub icon.

3. Click the right mouse button and select Properties, or from the Service menu select
Devices → Properties.

4. Select the Tank Database tab.

5. Configure the Tank Database with Modbus® addresses of the new level gauge and
ATD devices.

6. In the WinSetup Workspace, select the Rosemount 2410 Tank Hub icon.

7. Click the right mouse button and select Properties, or from the Service menu select
Devices → Properties.
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8. Select the Tank Database tab.

9. Verify that the new devices connected to the Tankbus appear in the Device Type
column. Devices that appear in the list are properly communicating on the Tankbus.
Devices supported by the Rosemount Tank Gauging system will automatically be
identified by the Rosemount 2410.

10. Verify that the new devices are marked Not Configured in the Tank Position
column.
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11. In the Tank Position column, map the new devices to a tank by selecting the
appropriate number in the drop-down list.
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12. Verify that a new tank position appears in the right-hand pane of the Tank Database
window. In the example above, the new devices are mapped to tank position 4, and
a tank position was added to the list of tanks in order to allow configuration of tank
name and Modbus addresses for the new devices.

13. Type a name in the Tank Name field. This tank name should also be used at a later
stage when installing the tank to be associated with the current tank hub.

14. The Level Modbus Address field is enabled for the new level gauge. Specify a
Modbus address of your own choice. Note that it must be the same Modbus address
as configured in the system hub’s tank database for this level gauge.

15. In case an Auxiliary Tank Device (ATD) such as a Rosemount 2240S Multi-input
Temperature Transmitter is installed, the ATD Modbus Address field is enabled as
well.

Specify a Modbus address of your own choice. Note that it must be the same
Modbus address as configured in the system hub’s tank database.

For tank position 1, the ATD Modbus address is automatically configured as the
Modbus address of the Rosemount 2410 Tank Hub itself. All the non-level devices
on a tank are represented by a single ATD device in the Rosemount Tank Gauging
system.

16. Click the Apply button to store the tank database configuration.
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17. Select the Device Tags tab.

18. Verify that the TankMaster Level Tag is correct or enter a new one. 18. Verify that
the TankMaster ATD Tag is correct or enter a new one. In case there are no ATD
device associated with the tank, the ATD tag field will be disabled.

19. Click the Install New Devices in TankMaster button to automatically install the
devices in the TankMaster Workspace. This is the recommended way of installing
field devices in TankMaster, but you may install the devices at a later stage by using
the device installation wizard.

20. Click the OK button to store the configuration and close the configuration window.

21. The devices will now be available in the TankMaster workspace, and each device has
to be configured via it's Properties window.

22. Proceed with installing the tank.

Now the new tank and field devices are installed and configured and will appear in
the TankMaster workspace.

Related information

Installing a tank
Device installation
Installing a Rosemount 2460 System Hub
Installing a Rosemount 2410 Tank Hub
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3.3 Calibrating the level gauge
Normally a minor level gauge adjustment is needed in order to accurately match
measured and actual product levels. For example, a deviation may result from minor errors
in tank geometry parameters such as the tank height (R) or the position of the Gauge
Reference Point.

The Rosemount 5900 level gauge can be manually calibrated by adjusting the Calibration
Distance parameter. For Rosemount 5900 gauges in Still-pipe applications you may use
the Calibrate function to let WinSetup automatically calculate an optimized Correction
Factor and Calibration Distance based on measurement data and hand dipping at
different product levels.

Related information

Rosemount 5900S Reference Manual

3.3.1 Manual adjustment of Calibration Distance
This is a description of how to manually adjust the Calibration Distance parameter.

A Rosemount 5900 level gauge can be calibrated manually by adjusting the Calibration
Distance(8) parameter. the Calibration Distance can be calculated by comparing hand
dipped level values with product levels measured by the gauge according to the formula:

New Calibration Distance=Old Calibration Distance+ΔL,

where ΔL=observed level (hand dip) - gauge level reading.

Procedure

1. In the WinSetup workspace, select the desired level gauge icon.

2. Click the right mouse-button and select Properties.

3. Select the Geometry tab.

4. Type the Calibration Distance value in the corresponding input field and click the
OK button.

Related information

Rosemount 5900S Reference Manual
Installing a Rosemount 5900 Radar Level Gauge

(8) For non-standard antennas the Tank Connection Length (TCL) may need to be adjusted as well.
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3.3.2 Using the Calibrate function
The Calibrate tool allows you to calculate the Correction Factor and Calibration Distance
for still-pipe measurements. It optimizes measurement performance from the top to the
bottom of the tank by automatically minimizing the offset between actual product levels
and level values measured by the gauge.

This is a brief description of how to use the Calibrate function. See the Rosemount 5900S
Reference Manual for further information.

Procedure

1. Select the Rosemount 5900 icon in the Workspace window.

2. Click the right mouse button and select Calibrate, or from the Service menu, select
Devices → Calibrate.

The Calibrate window displays a straight line fitted through measurement points
that represent the difference between hand dipped level values and values
measured by the level gauge. For still-pipe antennas a sloping line is displayed,
otherwise the line is horizontal.

3. Click the Calibration Data button to open the Calibration Data window. Enter hand
dipped level values and the corresponding levels measured by the gauge.

4. Once finished, click the Save Calibration Data in PC Database button and return to
the Calibrate window.

5. Click the Write new calibration data to RTG button to store the current calibration
data in the level gauge internal memory.
A new Calibration Distance will be calculated and the level values measured by the
gauge are recalculated.

Related information

Rosemount 5900S Reference Manual
Installing a Rosemount 5900 Radar Level Gauge
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3.4 Setting up a Tank Capacity Table
The tank geometry can be specified in the Tank Capacity Table (TCT). The TCT maps
product level to the corresponding volume. Several TCT types are available: Raw;
International, and Northern.

Procedure

1. Start the TankMaster WinSetup program.

2. In the WinSetup workspace window select the desired tank icon.

3. Click the right mouse button and select Tank Capacity.
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4. Select desired TCT type and enter level and volume data.

See the Rosemount TankMaster WinOpi Reference Manual for further information.

5. Click OK to save the configuration.

Related information

Rosemount TankMaster WinOpi Reference Manual
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3.5 Tank Entry
The Tank Entry window lets you specify a number of product parameters for inventory
calculations. TankMaster can use measured data, or data that is manually entered.

Procedure

1. In the WinSetup workspace window select the desired tank icon.

2. Click the right mouse button and select Tank Entry.

3. To enter manual values, select the corresponding check box and type the desired
value in the input field.

Manual values are marked yellow.

4. Click OK to save the configuration.

Related information

Rosemount TankMaster WinOpi Reference Manual
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3.6 Setting up a hybrid system
This is a description of how to install a Rosemount Tank Gauging system for on-line density
measurements and mass calculations.

Prerequisites

Before starting the setup make sure the 2460 System Hub's tank database is configured
accordingly.

For mass calculations to work properly, a tank strapping table (also referred to as a Tank
Capacity Table) must be entered.

A Rosemount Tank Gauging hybrid system typically includes two pressure sensors, P1 and
P3, and a Rosemount 5900S Radar Level Gauge. In case there is always atmospheric
pressure in the tank, the P3 sensor may be excluded.

Procedure

1. Start the TankMaster WinSetup program.

2. In the Workspace window select the tank server icon (This Workstation in the
example below).

3. Click the right mouse button and select Setup, or select menu option Service →
Servers → Setup to open the Server Preferences window.

4. Select the Units tab.

5. Select the desired measurement units for Density and Pressure.
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6. Select the Inventory tab.

7. For Local Gravity select calculation method Manual or Calculated. The Local Gravity
is used as input for calculating the Observed Density.

Manual: enter a local gravity value in the “Value” field.

Calculated: enter the latitude and elevation of the site where the tank is located.

8. Click the OK button to store the configuration and close the window.

9. In the Workspace window select the ATD device icon:

10. Click the right mouse button and select Properties, or from the Service menu select
Devices  → Properties to open the 22XX ATD window.
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11. Select the Advanced Parameter Source Configuration tab.

12. Verify that Vapor Pressure and Liquid Pressure are mapped to the correct pressure
sensors (Source Device).

13. Click the OK button to store the configuration and close the window.

14. Open the Tank Configuration window:

a) In WinSetup select the desired tank icon in the workspace window

b) Click the right mouse button and select Properties, or select menu option
Service → Tanks → Properties.
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15. Select the Configuration tab.

16. Select source parameter and measurement unit for Vapor Pressure and Liquid
Pressure.

17. Verify measurements by opening the Tank View window (Service → Tanks → Open
Tank View).

18. Configure the Liquid Pressure and Vapor Pressure sensors. In the WinSetup
workspace window right-click the tank icon and select Hybrid Tank Setup, or select
menu option Service → Tanks → Hybrid Tank Setup.
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19. Configure P1 Sensor Position and P3 Sensor Position.

• P1 Sensor Position is the center position of the sensor membrane for the Liquid
Pressure transmitter

• P3 Sensor Position is the center position of the sensor membrane for the Vapor
Pressure transmitter

20. Enter the Hybrid Min Level.

This value specifies the lowest product level at which TankMaster calculates the
Observed Density. Normally, the accuracy of pressure sensors is poor at low
pressures, i.e. at product levels close to the sensor membrane. Therefore, you can
enter a limit below which the density calculation is “frozen”. For example, if Hybrid
Min Level is equal to 0.6 meter, TankMaster WinOpi will present the same density
value for product levels below 0.6 meter.

Note
Specify the actual minimum product level and not the distance between the
pressure sensor and the product surface.

21. Click the Apply button to save the Hybrid Tank Setup configuration, or the OK
button to save and close the window.
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22. In the WinSetup workspace window select the tank icon, click the right mouse
button and select Tank Entry, or select menu option Service → Tanks → Tank
Entry.

23. Ensure that Reference Density is measured automatically, i.e. the check box Ref
Density is unmarked.

24. Click the Apply button to save the configuration, or click the OK button to save the
configuration and close the window.

Tank installation Reference Manual
February 2022 00809-0300-5100

160 Emerson.com/Rosemount



25. Open WinSetup. Click the right mouse button on the tank icon and select
Properties, or select menu option Service → Tanks  → Properties.

26. Select the Value Entry tab. Ensure that Value Source is set to Automatic for the
Liquid Pressure and Vapor Pressure measurement variables.

27. Click the OK button to save the configuration and close the window.

28. Check the result in the Tank Inventory window:

a) Start the TankMaster WinOpi program.

b) In the WinOpi workspace select the tank icon.

c) From the View menu, select Tank → Tank Inventory.

If the inventory calculations seem to be incorrect, see Checklist for Inventory
Parameter Setup in the Rosemount TankMaster WinOpi Reference Manual.

Related information

Advanced parameter source configuration
Installing a Rosemount 2460 System Hub
Setting up a Tank Capacity Table
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4 Device handling
This section provides information on how to change configuration of installed devices.

4.1 To change device configuration
Once a device is installed and configured, you can modify the current settings at any time
by in the Properties dialog.

Procedure

1. In the WinSetup Workspace window, open the Devices folder, navigate to the
desired device, and select the device icon. Click the right mouse button and select
Properties, or from the Service menu select Devices  → Properties.

Reference Manual Device handling
00809-0300-5100 February 2022

Rosemount Tank Gauging 163



2. The device properties window (in this example the 5900S RLG Properties window)
appears with multiple tabs that allow you to change the current device settings.

Various tabs allow you to configure communication parameters, tank geometry,
device specific parameters and advanced options.

Some tabs refer to steps in the device installation wizard. Similar dialogs are
available for other device types as well, for example the Rosemount 2410 Tank Hub.

Related information

Device installation
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4.2 To uninstall a device
A device can be uninstalled from the WinSetup workspace at any time. However, prior to
uninstalling the device it needs to be disconnected from the associated tank.

Procedure

1. In the WinSetup workspace, select the desired tank.

2. Click the right mouse button and select Properties, or from the Service menu select
Devices  → Properties.

3. Select the Configuration tab.
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4. Click the Change button.

5. In the right-hand side of the Select Devices window, select the device (LT-TK-1 in this
example) and click the left-arrow button. The device will be moved from the
Selected Devices pane to the Available Devices pane.

6. Click the OK button.

7. Open the Tanks and Devices folders:

8. Verify that the device (LT-TK-1 in this case) is no longer associated with the tank but
still available in the Devices folder.

9. Select the device and click the right mouse button.
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10. Select Uninstall.

Now the device will be removed. However, the tank is still available in the WinSetup
workspace.
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4.3 To uninstall a tank and associated devices
In case you wish to uninstall a tank and its associated devices, you will have to start by
uninstalling the tank and then proceed with uninstalling the devices.

Procedure

1. Uninstall the tank.

2. Select the device and click the right mouse button.

3. Select Uninstall.

4. Repeat for each device you wish to remove.

Related information

To uninstall a tank
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